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Chapter 1: WLAN 802.11a Transmitter Test

Introduction
The WLAN_802_11a_TX transmitter test bench (user equipment to base station)
provides a way for users to connect to an RF circuit device under test (RF DUT) and
determine its performance by activating various test bench measurements. This test
bench provides signal measurements for RF envelope, signal power (including
CCDF), constellation, spectrum, and EVM.

The signal and most of the measurements are designed according to IEEE Standard
802.11a-1999.

This WLAN signal source model is compatible with the Agilent Signal Studio
Software option 417 for transmitter test. Details regarding Signal Studio for WLAN
802.11 are included at the website http://www.agilent.com/find/signalstudio.

The RF DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source
resistance, RF DUT connection, RF receivers, and DSP measurement blocks, as
illustrated in Figure 1-1. The generated test signal is sent to the DUT.

Figure 1-1. Transmitter Wireless Test Bench Block Diagram

The WLAN 802.11a/g signal burst structure is illustrated in Figure 1-2 and
Figure 1-3. Each burst, separated by an IdleInterval, is composed of the Short
Preamble, Long Preamble, SIGNAL, and DATA fields. (In Figure 1-2 and Figure 1-3,
PLCP means physical layer convergence procedure, PSDU means PLCP service data
units, GI means guard interval; GI is set to 0.25 and Bandwidth is set to 20 MHz
(resulting in OFDM_SymbolTime = 4 µsec).
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WLAN 802.11a Transmitter Test
• Short Preamble consists of 10 short preambles (8 µsec).

• Long Preamble consists of 2 long preambles (8 µsec). The two preamble fields
combined compose the PLCP Preamble that has a constant time duration (16
µsec) for all source parameter settings.

• SIGNAL includes 802.11a/g bursts of information (such as data rate, payload
data, and length).

• DATA contains payload data.

Channel coding, interleaving, mapping and IFFT processes are also included in
SIGNAL and DATA parts generation. The SIGNAL field and each individual Data
field (part of the overall DATA field) have a time duration defined as
OFDM_SymbolTime and includes a GuardInterval. OFDM _SymbolTime depends on
the Bandwidth (=64/Bandwidth).

Figure 1-2. 802.11a/g Burst Structure

Figure 1-3. OFDM Training Structure

WLAN RF power delivered into a matched load is the average power delivered in the
WLAN burst excluding the burst idle time. Figure 1-4 shows the RF envelope for an
output RF signal with 10 dBm power.
1-2 Introduction



Figure 1-4. RF Signal Envelope

Test Bench Basics
A template is provided for this test bench.

Figure 1-5. WLAN 802.11a Transmitter Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11a_TX_test, click OK;
click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click
File > Example Project > WLAN > WLAN_RF_Verification_prj >
WLAN_802_11a_TX_test.dsn.

The basics for using the test bench are:
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WLAN 802.11a Transmitter Test
• Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

• CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your requirements.

• Activate/deactivate measurements based on your requirements.

• Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to “Test Bench Details” on page 1-4.

Test Bench Details
The following sections provide details for setting up a test bench, setting
measurement parameters for more control of the test bench, simulation
measurement displays, and baseline performance.

Open and use the WLAN_802_11a_TX template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11a_TX_test, click OK;
click left to place the template in the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

For information regarding using certain types of DUTs, see Appendix A, RF
DUT Limitations.

2. Set the Required Parameters

Note Refer to “WLAN_802_11a_TX” on page 1-8 for a complete list of
parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by
the user as needed.
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• Set CE_TimeStep.

Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Agilent Circuit Envelope simulation
technology). Each technology requires its own simulation time step with
time-step coordination occurring in the interface between the technologies.

CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=25 nsec.
The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/(Bandwidth × Ratio)

where

Bandwidth is the user-settable value (default 20 MHz)
Ratio is the oversampling ratio related to OversamplingOption as Ratio =
2OversamplingOption. OversamplingOption sets the number of waveform
sampling points during the signal FFT time interval. During this time
interval the minimum FFT sampling size is 64 (which corresponds to an FFT
order of 6; i.e 26) and the FFT time interval is defined as 64/Bandwidth. For
example, an OversamplingOption of 2 sets the FFT sampling size to
64 × 4=256 (which corresponds to an FFT order of 8) during the signal FFT
time interval.

• Set FSource, SourcePower, and FMeasurement.

• FSource defines the RF frequency for the signal input to the RF DUT.

• SourcePower defines the power level for FSource. SourcePower is defined as
the average power during the non-idle time of the signal burst.

• FMeasurement defines the RF frequency output from the DUT to be
measured.

3. Activate/deactivate (YES/NO) test bench measurements (refer to
“WLAN_802_11a_TX” on page 1-8). At least one measurement must be enabled:

• RF_EnvelopeMeasurement

• Constellation
Test Bench Details 1-5



WLAN 802.11a Transmitter Test
• PowerMeasurement

• SpectrumMeasurement

• EVM_Measurement

4. More control of the test bench can be achieved by setting Basic Parameters,
Signal Parameters, and parameters for each activated measurement. For
details, refer to “Setting Parameters” on page 1-13.

5. The RF modulator (shown in the block diagram in Figure 1-1) uses FSource,
SourcePower (Required Parameters), MirrorSourceSpectrum (Basic
Parameters), GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset,
and IQ_Rotation (Signal Parameters).

The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise
(Basic Parameters). The RF output signal source has a 50-ohm (default) output
resistance defined by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource),
with the specified source resistance (SourceR) and with power (SourcePower)
delivered into a matched load of resistance SourceR. The RF signal has additive
Gaussian noise power set by resistor temperature (SourceTemp) (when
EnableSourceNoise=YES).

Note that the Meas_in point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) (Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Figure 1-1) uses other Signal
Parameters.

6. More control of Circuit Envelope analysis can be achieved by setting Envelope
controller parameters. These settings include Enable AVM (Fast Cosim), which
may speed the RF DUT simulation more than 10×. Setting these simulation
options is described in Setting Automatic Verification Modeling Parameters and
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench
Simulation documentation.

7. To send the RF DUT output signal to an Agilent ESG RF signal generator, set
Signal to ESG Parameters.

For details, refer to “Signal to ESG Parameters” on page 1-29.
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8. To run a simulation, choose Simulate > Simulate in the Schematic window.

For details on Running a Simulation refer to the Wireless Test Bench
Simulation documentation.

9. Simulation results will appear in a Data Display window for each
measurement. “Simulation Measurement Displays” on page 1-31 describes
results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation
documentation.
Test Bench Details 1-7



WLAN 802.11a Transmitter Test
WLAN_802_11a_TX

This section provides parameter information for Required Parameters, Basic
Parameters, Signal Parameters, and parameters for the various measurements.

Parameters

Name Description Default Sym Unit Type Range

RequiredParameters

CE_TimeStep Circuit envelope simulation
time step

1/20 MHz/4 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep<
=1/Bandwidth/2^Oversamp
lingOption.
  Expression variables are
in Signal Parameters
tab/category.

FSource Source carrier frequency:
CH1_2412.0MHz,
CH3_2422.0MHz,
CH5_2432.0MHz,
CH6_2437.0MHz,
CH7_2442.0MHz,
CH9_2452.0MHz,
CH11_2462.0MHz,
CH13_2472.0MHz,
CH36_5180.0MHz,
CH40_5200.0MHz,
CH44_5220.0MHz,
CH48_5240.0MHz,
CH52_5260.0MHz,
CH56_5280.0MHz,
CH60_5300.0MHz,
CH64_5320.0MHz,
CH149_5745.0MHz,
CH153_5765.0MHz,
CH157_5785.0MHz,
CH161_5805.0MHz

CH1_2412.0MHz Hz real enum (0, ∞)

SourcePower Source power dbmtow(-20.0) W real [0, ∞)
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FMeasurement Measurement carrier
frequency:
Meas_CH1_2412.0MHz,
Meas_CH3_2422.0MHz,
Meas_CH5_2432.0MHz,
Meas_CH6_2437.0MHz,
Meas_CH7_2442.0MHz,
Meas_CH9_2452.0MHz,
Meas_CH11_2462.0MHz,
Meas_CH13_2472.0MHz,
Meas_CH36_5180.0MHz,
Meas_CH40_5200.0MHz,
Meas_CH44_5220.0MHz,
Meas_CH48_5240.0MHz,
Meas_CH52_5260.0MHz,
Meas_CH56_5280.0MHz,
Meas_CH60_5300.0MHz,
Meas_CH64_5320.0MHz,
Meas_CH149_5745.0MHz
,
Meas_CH153_5765.0MHz
,
Meas_CH157_5785.0MHz
,
Meas_CH161_5805.0MHz

Meas_CH1_2412
.0MHz

Hz real enum (0, ∞)

MeasurementInfo Available Measurements
  Each measurement has
parameters on its
tab/category below.

RF_EnvelopeMeasurement Enable RF envelope
measurement? NO, YES

YES enum

Constellation Enable constellation
measurement? NO, YES

NO enum

PowerMeasurement Enable power
measurement? NO, YES

NO enum

SpectrumMeasurement Enable spectrum
measurement? NO, YES

NO enum

EVM_Measurement Enable EVM
measurement? NO, YES

NO enum

BasicParameters

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor
temperature

-273.15 Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO enum

MeasR Measurement resistance 50 Ohm Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO enum

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO enum

Name Description Default Sym Unit Type Range
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WLAN 802.11a Transmitter Test
RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO enum

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO enum

TestBenchSeed Random number generator
seed

1234567 int [0, ∞)

SignalParameters

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0 real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0 real (-∞, ∞)

IQ_Rotation IQ rotation 0.0 deg real (-∞, ∞)

Bandwidth Bandwidth 20 MHz  B Hz real (0, ∞)

OversamplingOption Oversampling ratio option:
Option 0 for Ratio 1, Option
1 for Ratio 2, Option 2 for
Ratio 4, Option 3 for Ratio
8, Option 4 for Ratio 16,
Option 5 for Ratio 32

Option 2 for Ratio
4

 S enum

DataRate Data rate (Mbps): Mbps_6,
Mbps_9, Mbps_12,
Mbps_18, Mbps_24,
Mbps_27, Mbps_36,
Mbps_48, Mbps_54

Mbps_54  R enum

IdleInterval Burst idle interval 4.0 usec  I sec real [0, 1000usec]

DataType Payload data type: PN9,
PN15, FIX4, _4_1_4_0,
_8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9 enum

DataLength Data length (bytes per
burst)

100  L int [1, 4095]

GuardInterval Guard interval (frac FFT
size)

0.25 real [0, 1]

RF_EnvelopeMeasurementParam
eters

RF_EnvelopeDisplayPages RF envelope measurement
display pages:
  WLAN_802_11a_TX
Envelope RF Figures
  WLAN_802_11a_TX
Envelope Meas Figures
  WLAN_802_11a_TX
Envelope Equations

Name Description Default Sym Unit Type Range
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RF_EnvelopeStart RF envelope measurement
start

0.0 sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

100.0 usec sec real [RF_EnvelopeSt

art, ∞)

RF_EnvelopeBursts RF envelope measurement
bursts

3 int [0, 100]

ConstellationParameters

ConstellationDisplayPages Constellation
measurement display
pages:
  WLAN_802_11a_TX
Constellation Figures

ConstellationStartBurst Constellation
measurement start burst

0 int [0, 100]

ConstellationBursts Constellation
measurement bursts

3 int [1, 100]

PowerMeasurementParameters

PowerDisplayPages Power measurement
display pages:
  WLAN_802_11a_TX
Power
Figures/Tables/Equations

PowerBursts Power measurement
bursts

3 int [1, 100]

SpectrumMeasurementParameter
s

SpectrumDisplayPages Spectrum  measurement
display pages:
  WLAN_802_11a_TX
Spectrum Equations
  WLAN_802_11a_TX
Spectrum Figures/Tables

SpecMeasStart Spectrum measurement
start

0.0 sec real [0, ∞)

SpecMeasStop Spectrum measurement
stop

100.0 usec sec real [SpecMeasStart
+
16*MaxTimeSte

p, ∞)

SpecMeasBursts Spectrum measurement
bursts

3 int [0, 100]

SpecMeasResBW Spectrum resolution
bandwidth

100 kHz Hz real [0, ∞)

Name Description Default Sym Unit Type Range
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WLAN 802.11a Transmitter Test
SpecMeasWindow Window type: none,
Hamming 0.54, Hanning
0.50, Gaussian 0.75,
Kaiser 7.865, _8510 6.0,
Blackman,
Blackman-Harris

Kaiser 7.865 enum

EVM_MeasurementParameters

EVM_DisplayPages EVM measurement display
pages:
  WLAN_802_11a_TX
EVM Tables

EVM_Start EVM measurement start 0.0 sec real [0, ∞)

EVM_AverageType Average type: Off, RMS
(Video)

RMS (Video) enum

EVM_BurstsToAverage Bursts used for RMS
averaging

10 int [1, ∞)

EVM_DataModulationFormat Data subcarrier modulation
format: Auto Detect, BPSK,
QPSK, QAM 16, QAM 64

Auto Detect enum

EVM_SearchLength Search length 0.001 sec real (0, ∞)

EVM_ResultLengthType Resul length type: Auto
select, Manual Override

Auto select enum

EVM_ResultLength Manual override result
length (symbols)

60 int [1, 1367]

EVM_MeasurementOffset Measurement offset
(symbols)

0 int [0, ∞)

EVM_MeasurementInterval Measurement interval
(symbols)

11 int [1, ∞)

EVM_SymbolTimingAdjust Timing adjustment (% FFT
time)

-3.125 real [-100*GuardInte
rval,  0]

EVM_SyncType Synchronization type:
Short Training Seq,
Channel Estimation Seq

Short Training
Seq

enum

SignalToESG_Parameters

EnableESG Enable signal to ESG? NO,
YES

NO enum

ESG_Instrument ESG instrument address [GPIB0::19::INST
R][localhost][4790
]

instrument

ESG_Start Signal start 0.0 sec real [0, ∞)

ESG_Stop Signal stop 100.0 usec sec real [(ESG_Start+60
*50ns/pow(2.0,
S)),
(ESG_Start+32
e6*50ns/pow(2.
0,S))]

Name Description Default Sym Unit Type Range
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Pin Inputs

Pin Outputs

Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

ESG_Bursts Bursts to ESG 3 int [0, 1000]

ESG_Power ESG RF ouput power
(dBm)

-20.0 real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal enum

ESG_ExtClkRefFreq External clock reference
freq

10 MHz Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz,
filter_40MHz

through enum

ESG_SampleClkRate Sequencer sample clock
rate

80 MHz Hz real (0, ∞)

ESG_Filename ESG waveform storage
filename

WLAN_54 string

ESG_AutoScaling Activate auto scaling? NO,
YES

YES enum

ESG_ArbOn Select waveform and turn
ArbOn after download?
NO, YES

YES enum

ESG_RFPowOn Turn RF ON after
download? NO, YES

YES enum

ESG_EventMarkerType Event marker type: Neither,
Event1, Event2, Both

Event1 enum

ESG_MarkerLength ESG marker length 10 int [1, 60]

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

Pin Name Description

1 RF_Out Test bench RF output to RF circuit

Name Description Default Sym Unit Type Range
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Note For required parameter information, see “Set the Required Parameters” on
page 1-4.

Basic Parameters

1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k
is Boltzmann’s constant.

3. EnableSourceNoise, when set to NO disables the SourceTemp and effectively

sets it to -273.15oC (0 Kelvin). When set to YES, the noise density due to
SourceTemp is enabled.

4. MeasR defines the load resistance for the RF DUT output Meas signal into the
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for Meas signal power measurements.

5. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the
generated RF signal before it is sent to the RF DUT. Depending on the
configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set
this parameter to YES.

6. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the
Meas_in RF signal input to the test bench (and output from the RF DUT).
Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the
signal source (before any mirroring is done because of the
MirrorSourceSpectrum setting). Proper demodulation and measurement of the
RF DUT output signal requires that its RF envelope is not mirrored compared
to the signal generated by the signal source (before any mirroring is done
because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is
required for measurements on the Meas_in signal in TX test benches (EVM,
Constellation, CDP, PCDE) and results in measurement on a signal with no
spectrum mirroring.
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7. TestBenchSeed is an integer used to seed the random number generator used
with the test bench. This value is used by all test bench random number
generators, except those RF DUT components that use their own specific seed
parameter. TestBenchSeed initializes the random number generation. The
same seed value produces the same random results, thereby giving you
predictable simulation results. To generate repeatable random output from
simulation to simulation, use any positive seed value. If you want the output to
be truly random, enter the seed value of 0.

8. RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out
RF signal for RF envelope, ppectrum, ACLR, and occupied bandwidth
measurements. RF_MirrorFreq is typically set by the user to NO when
MirrorSourceSpectrum = NO; RF_MirrorFreq is typically set by the user to
YES when MirrorSourceSpectrum = YES. Both settings result in viewing the
RF_out signal with no spectrum mirroring. Other settings by the user result in
RF_out signal for RF_Envelope and Spectrum measurements with spectrum
mirroring.

9. MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in
RF signal for the RF envelope, spectrum, ACLR, and occupied bandwidth
measurements.

MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT
results in no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is
typically set to YES by the user when the combination of the
MirrorSourceSpectrum and RF DUT results in spectrum mirroring in the
Meas_in signal.

Other settings result in Meas_in signal for RF_Envelope and Spectrum
measurements with spectrum mirroring. The MirrorMeasSpectrum parameter
setting has no impact on the setting or use of the MeasMirrorFreq parameter.
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Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and
IQ_Rotation are used to add certain impairments to the ideal output RF signal.
Impairments are added in the order described here.

The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI(t) is the in-phase RF envelope, VQ(t) is the
quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.

Next, the signal VRF(t) is rotated by IQ_Rotation degrees. The I_OriginOffset
and Q_OriginOffset are then applied to the rotated signal. Note that the
amounts specified are percentages with respect to the output rms voltage. The
output rms voltage is given by sqrt(2 × SourceR × SourcePower).

2. Bandwidth is used to determine the actual bandwidth of WLAN systems and to
calculate the sampling rate and timestep per sample. The default value is 20
MHz (defined in 802.11a/g specification); to double the rate for the 802.11a/g
turbo mode, set Bandwidth to 40 MHz.

3. OversamplingOption sets the oversampling ratio of 802.11a/g RF signal source.
Options from 0 to 5 result in oversampling ratio 2, 4, 8, 16, 32 where
oversampling ratio = 2OversamplingOption. If OversamplingOption = 2, the
oversampling ratio = 22 = 4 and the simulation RF bandwidth is larger than the
signal bandwidth by a factor of 4 (e.g. for Bandwidth=20 MHz, the simulation
RF bandwidth = 20 MHz × 4 = 80 MHz).

4. DataRate specifies the data rate 6, 9, 12, 18, 24, 27, 36, 48 and 54 Mbps. All
data rates except 27 Mbps are defined in the 802.11a/g specification; 27 Mbps is
from HIPERLAN/2.

Table 1-1 lists key parameter values of 802.11a/g.
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5. IdleInterval specifies the idle interval between two consecutive bursts when
generating a 802.11a signal source.

6. For DataType:

• if PN9 is selected, a 511-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.153.

• if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.

• if FIX4 is selected, a zero-stream is generated.

• if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s
and the second x bits are 0s.

7. DataLength is used to set the number of data bytes in a burst. There are 8 bits
per byte.

8. GuardInterval is used to set cyclic prefix in an OFDM symbol. The value range
of GuardInterval is [0.0,1.0]. The cyclic prefix is a fractional ratio of the IFFT
length. 802.11a/g defines GuardInterval=1/4 (0.8 µsec) and HIPERLAN/2
defines two GuardIntervals (1/8 and 1/4).

Table 1-1. Rate-Dependent Values

Data Rate
(Mbps) Modulation Coding Rate (R)

Coded Bits per
Subcarrier
( )

Coded Bits per
OFDM Symbol
( )

Data Bits per
OFDM Symbol
( )

6 BPSK 1/2 1 48 24

9 BPSK 3/4 1 48 36

12 QPSK 1/2 2 96 48

18 QPSK 3/4 2 96 72

24 16-QAM 1/2 4 192 96

27 16-QAM 9/16 4 192 108

36 16-QAM 3/4 4 192 144

48 64-QAM 2/3 6 288 192

54 64-QAM 3/4 6 288 216

NBPSC NCBPS NDBPS
Setting Parameters 1-17



WLAN 802.11a Transmitter Test
RF Envelope Measurement Parameters

The RF Envelope measurement is not affected by the MirrorMeasSpectrum
parameter. To apply spectrum mirroring to the measured RF_out signal, set
RF_MirrorFreq=YES; to apply spectrum mirroring to the measured Meas_in signal,
set MeasMirrorFreq=YES (Basic Parameters).

• RF_EnvelopeDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

• RF_EnvelopeStart sets the start time for collecting input data.

• RF_EnvelopeStop sets the stop time for collecting input data when
RF_EnvelopeBursts = 0.

• RF_EnvelopeBursts (when > 0) sets the number of bursts over which data will
be collected.

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and
RF_EnvelopeBursts, the stop time may be adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:

Start = TimeStep× (int(RF_EnvelopeStart/TimeStep) + 0.5)

Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step
intervals.

For the RF envelope of Meas_in to contain at least one complete burst, set the Stop
value to a minimum of BurstTime + (RF DUT time delay).

For information about TimeStep and SubframeTime, see “Test Bench Variables for
Data Displays” on page 1-50.

RF_EnvelopeBursts Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeBursts x BurstTime
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Constellation Parameters

The Constellation measurement requires setting of the MirrorMeasSpectrum
parameter set such that there is an even number of spectrum mirrorings from the
combined test bench source and RF DUT. For example, if MirrorSourceSpectrum=NO
and the RF DUT causes its output RF signal to have spectrum mirroring relative to
its input signal, then set MirrorMeasSpectrum = YES.

1. ConstellationDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

2. ConstellationStartBurst sets the start time for collecting the first burst data.
The ConstellationStartBurst value can be set > 0 to avoid any start-up
transient in the Constellation plots.

3. ConstellationBursts sets the number of bursts over which data will be collected.

The measurement start time is the time when ConstellationStartBurst is detected in
the measured RF signal. The measurement stop time is this start time plus
ConstellationBursts × BurstTime; BurstTime is defined in Table 1-12.

Power Measurement Parameters

1. PowerDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

2. PowerBursts (when > 0) sets the number of bursts over which data will be
collected.

The measurement start time is the time when the first burst is detected in the
measured RF signal. The measurement stop time is this start time plus PowerBursts
× BurstTime; BurstTime is defined in Table 1-12.
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Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging
the spectrum over multiple bursts can be enabled as described in this section.

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES; to
apply spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq =
YES.

In the following, TimeStep denotes the simulation time step, and FMeasurement
denotes the measured RF signal characterization frequency.

1. The measurement outputs the complex amplitude voltage values at the
frequencies of the spectral tones. It does not output the power at the frequencies
of the spectral tones. However, one can calculate and display the power
spectrum as well as the magnitude and phase spectrum by using the dBm, mag,
and phase functions of the data display window.

Note that the dBm function assumes a 50-ohm reference resistance; if a
different measurement was used in the test bench, its value can be specified as
a second argument to the dBm function, for example, dBm(SpecMeas,
Meas_RefR) where SpecMeas is the instance name of the spectrum
measurement and Meas_RefR is the resistive load.

By default, the displayed spectrum extends from
FMeasurement - 1/(2 × TimeStep) Hz to FMeasurement + 1/(2 × TimeStep) Hz.
When FMeasurement < 1/(2 × TimeStep), the default spectrum extends to
negative frequencies. The spectral content at these negative frequencies is
conjugated, mirrored, and added to the spectral content of the closest positive
frequency. This way, the negative frequency tones are displayed on the positive
frequency axis as would happen in an RF spectrum analyzer measurement
instrument. This process may introduce an error in the displayed frequency for
the mirrored tones. The absolute error introduced is less than
(Spectrum Frequency Step) / 2 (see Table 1-2 for the definition of Spectrum
Frequency Step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple bursts and average the results to
achieve video averaging (see note 6).

2. SpectrumDisplayPages is not user editable. It provides information on the
name of the Data Display pages in which this measurement is contained.
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3. SpecMeasStart sets the start time for collecting input data.

4. SpecMeasStop sets the stop time for collecting input data when
SpecMeasBursts = 0 and SpecMeasResBW = 0.

5. SpecMeasBursts sets the number of bursts over which data will be collected
when SpecMeasBursts>0.

6. SpecMeasResBW sets the resolution bandwidth of the spectrum measurement
when SpecMeasResBW>0.

Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasBursts,
and SpecMeasResBW, the stop time may be adjusted or spectrum video
averaging may occur (or both). The different cases are described in Table 1-2.

Referring to Table 1-2 let

Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)

Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer number of time step
intervals.)

X = normalized equivalent noise bandwidth of the window

Equivalent noise bandwidth (ENBW) compares the window to an ideal,
rectangular filter. It is the equivalent width of a rectangular filter that passes
the same amount of white noise as the window. The normalized ENBW
(NENBW) is ENBW multiplied by the duration of the signal being windowed.
Table 1-3 lists the NENBW for the various window options.

The Start and Stop times are used for both the RF_out and Meas_in signal
spectrum analyses. The Meas_in signal is delayed in time from the RF_out
signal by the value of the RF DUT time delay. Therefore, for RF DUT time delay
greater than zero, the RF_out and Meas_in signal are inherently different and
some spectrum display difference in the two is expected.

TimeStep and BurstTime are defined in the Test Bench Variables for Data
Displays section.
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Table 1-2. Effect of Values for
SpecMeasStart, SpecMeasStop, SpecMeasBursts, and SpecMeasResBW

Case 1 SpecMeasBursts = 0
SpecMeasResBW = 0

Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case 2 SpecMeasBursts > 0
SpecMeasResBW = 0

Resultant stop time = Start + SpecMeasBurst x BurstTime
Notes: For SpecMeasBursts > 0 and SpecMeasResBW = 0
- Video averaging occurs over all burst time intervals

Resultant resolution BW = X /BurstTime
Resultant spectrum frequency step = 1/BurstTime
Video averaging status = Yes, when SpecMeasBursts > 1

Case 3 SpecMeasBursts = 0
SpecMeasResBW > 0

Resultant stop time = Start + N x BurstTimeInterval
where
N = int((Stop -Start)/BurstTimeInterval) + 1

For SpecMeasBursts = 0 and SpecMeasResBW > 0
Define BurstTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means BurstTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (N) of BurstTimeIntervals
N has a minimum value of 1
Video averaging occurs over all BurstTimeIntervals
The resolution bandwidth achieved is ResBW = X / BurstTimeInterval, which is very close to SpecMeasResBW but may
not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case 4 SpecMeasBursts > 0
SpecMeasResBW > 0

Resultant stop time = Start + M x BurstTimeInterval
where

M = int((SpecMeasBursts x BurstTime)/BurstTimeInterval) + 1

For SpecMeasBursts > 0 and SpecMeasResBW > 0
Define BurstTimeInterval = TimeStep x int(( X /SpecMeasResBW/TimeStep) + 0.5)
This means BurstTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (M) of the BurstTimeIntervals
M has a minimum value of 1
Video averaging occurs over all BurstTimeIntervals
The resolution bandwidth achieved is ResBW = X / BurstTimeInterval, which is very close to SpecMeasResBW but may
not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1
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7. SpecMeasWindow specifies the window that will be applied to each burst before
its spectrum is calculated. Different windows have different properties, affect
the resolution bandwidth achieved, and affect the spectral shape. Windowing is
often necessary in transform-based (chirp-Z, FFT) spectrum estimation in order
to reduce spectral distortion due to discontinuous or non-harmonic signal over
the measurement time interval. Without windowing, the estimated spectrum
may suffer from spectral leakage that can cause misleading measurements or
masking of weak signal spectral detail by spurious artifacts.

The windowing of a signal in time has the effect of changing its power. The
spectrum measurement compensates for this and the spectrum is normalized so
that the power contained in it is the same as the power of the input signal.

Window Type Definitions:

• none:

where N is the window size

• Hamming 0.54:

where N is the window size

• Hanning 0.5:

where N is the window size
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where N is the window size

• Kaiser 7.865:

where N is the window size, α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind

• 8510 6.0 (Kaiser 6.0):

where N is the window size, α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind

• Blackman:

where N is the window size

• Blackman-Harris:

where N is the window size.
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EVM Measurement Parameters

The EVM measurement requires setting the MirrorMeasSpectrum parameter such
that there is an even number of spectrum mirrorings from the combined test bench
source and RF DUT. For example, if MirrorSourceSpectrum = NO and the RF DUT
causes its output RF signal to have spectrum mirroring relative to its input signal,
then set MirrorMeasSpectrum = YES.

The EVM measurement provides results for EVMrms_percent, EVM_dB,
PilotEVM_dB, CPErms_percent, IQ_Offset_dB, and SyncCorrelation. Following is a
description of the algorithm and parameter information.

1. EVM_DisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

2. Starting at the time instant specified by the EVM_Start, a signal segment of
length EVM_SearchLength is captured. This signal segment is searched to
detect a complete burst. The burst search algorithm looks for a burst-on and a
burst-off transition. In order for the burst search algorithm to detect a burst, an
idle part must exist between consecutive bursts and the bursts must be at least
15 dB above the noise floor.

The EVM_Start time is used for both the RF_out and Meas_in EVM analyses.
The Meas_in signal is delayed in time from the RF_out signal by the RF DUT
time delay value. Therefore, for RF DUT time delay >0, the RF_out and
Meas_in signals are inherently different and some EVM difference in the two is
expected even if the RF DUT does not introduce any distortion except time
delay.

Table 1-3. Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021
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If the captured signal segment does not contain a complete burst, the algorithm
will not detect any burst and the analysis that follows will most likely produce
the wrong results. Therefore, EVM_SearchLength must be long enough to
capture at least one complete burst. Since the time instant specified by the
EVM_Start parameter can be soon after the beginning of a burst, it is strongly
recommended that EVM_SearchLength is set to a value approximately equal to
2 x BurstTime + 3 x Idle, where BurstTime is the duration of a burst and Idle is
the duration of the idle part. If EVM_Start is known to be close to the beginning
of a burst then EVM_SearchLength can be set to BurstTime + 2 x Idle. If the
duration of the burst or the idle part is unknown, then the RF envelope of the
signal can be plotted and these durations determined by observing the plot.

After a burst is detected, synchronization is performed based on the value of
EVM_SyncType. The burst is then demodulated. The burst is then analyzed to
get the EVM measurement results.

3. If EVM_AverageType is set to Off, only one burst is detected, demodulated, and
analyzed.

If EVM_AverageType is set to RMS (Video), after the first burst is analyzed the
signal segment corresponding to it is discarded and new signal samples are
collected to fill in the signal buffer of length EVM_SearchLength. When the
buffer is full again, a new burst search is performed, and when a burst is
detected, it is demodulated and analyzed. These steps repeat until
EVM_BurstsToAverage bursts are processed.

If a burst is misdetected for any reason the results from its analysis are
discarded. EVM results obtained from all successfully detected, demodulated,
and analyzed bursts are averaged to give the final result.

4. EVM_DataModulationFormat can be used to specify the data subcarrier
modulation format. If EVM_DataModulationFormat is set to Auto Detect, the
algorithm will use the information detected within the OFDM burst (SIGNAL
symbol - RATE data field) to automatically determine the data subcarrier
modulation format. Otherwise, the format determined from the OFDM burst
will be ignored and the format specified by EVM_DataModulationFormat will
be used in the demodulation for all data subcarriers. This parameter has no
effect on demodulation of the pilot subcarriers and the SIGNAL symbol, whose
format is always BPSK.
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5. The EVM_ResultLengthType and EVM_ResultLength parameters control how
much data is acquired and demodulated.

When EVM_ResultLengthType is set to Auto select, the measurement result
length is automatically determined from information in the decoded SIGNAL
symbol (LENGTH data field). In this case, EVM_ResultLength defines a
maximum result length for the burst in symbol times; that is, if the
measurement result length that is automatically detected is larger than
EVM_ResultLength it will be truncated to EVM_ResultLength.

When EVM_ResultLengthType is set to Manual Override, the measurement
result length is set to EVM_ResultLength regardless of what is detected from
the SIGNAL symbol of the burst. The value specified in EVM_ResultLength
includes the SIGNAL symbol but does not include any part of the burst
preamble.

Table 1-4 summarizes the differences between how Auto Select and Manual
Override modes determine the measurement result length. The table lists the
measurement result lengths actually used for Auto Select and Manual Override
modes for three different values of the EVM_ResultLength parameter (30, 26
and 20 symbol-times). An input burst length of 26 symbol-times is assumed.

Note that when EVM_ResultLengthType is set to Manual Override and
EVM_ResultLength=30 (greater than the actual burst size) the algorithm will
demodulate the full 30 symbol-times even though this is 4 symbol-times beyond
the burst width.

6. The EVM_MeasurementInterval and EVM_MeasurementOffset parameters
can be used to isolate a specific segment of the EVM_ResultLength symbols for
analysis. Only the segment specified by these two parameters will be analyzed
in order to get the EVM results. Figure 1-6 shows the interrelationship between

Table 1-4. ResultLength Parameter Settings

EVM_ResultLengthType EVM_ResultLength
Measurement Result
Length Actually Used

Auto Select 20 20

Auto Select 26 26

Auto Select 30 26

Manual Override 20 20

Manual Override 26 26

Manual Override 30 30
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EVM_SearchLength, EVM_ResultLength, EVM_MeasurementInterval, and
EVM_MeasurementOffset.

Figure 1-6. Interrelationship Between EVM_SearchLength, EVM_ResultLength,
EVM_MeasurementInverval, and EVM_MeasurementOffset

7. Normally, when demodulating an OFDM symbol, the guard interval is skipped
and an FFT is performed on the last portion of the symbol time. However, this
means that the FFT will include the transition region between this and the
following symbol. To avoid this, it is generally beneficial to back away from the
end of the symbol time and use part of the guard interval.

The EVM_SymbolTimingAdjust parameter controls how far the FFT part of the
symbol is adjusted away from the end of the symbol time. The value is in terms
of percent of the used (FFT) part of the symbol time. Note that this parameter
value is negative, because the FFT start time is moved back by this parameter.
Figure 1-7 illustrates this concept. When setting this parameter, be careful to
not back away from the end of the symbol time too much because this may make
the FFT include corrupt data from the transition region at the beginning of the
symbol time.

8. EVM_SyncType specifies whether the synchronization type will be the Short
Training Sequence or the Channel Estimation Sequence.
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Figure 1-7. EVM_SymbolTimingAdjust Definition

Signal to ESG Parameters

The EVM measurement collects Meas_in signal data and downloads it to an Agilent
E4438C Vector Signal Generator. Connection Manager architecture isused to
communicate with the instrument; parameters specify how data is interpreted.

Prerequisites for using the Signal to ESG option are:

• ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg.

• PC workstation running an instance of the connection manager server.

• Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager.

• AgilentRfSigGen IVI-COM driver installed on the PC running the connection
manager server. This driver installation is made available as an option during
the connection manager server installation.
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Parameter Information

1. EnableESG specifies if the signal is downloaded to the ESG instrument. If set
to NO, no attempt will be made to communicate with the instrument.

2. ESG_Instrument specifies a triplet that identifies the VSA resource of the
instrument to be used in the simulation, the connection manager server
hostname (defaults to localhost), and the port at which the connection manager
server listens for incoming requests (defaults to 4790). To ensure that this field
is populated correctly, click Select Instrument, enter the server hostname and
port, click OK to see the Remote Instrument Explorer dialog, select a VSA
resource identifier, and click OK. For details about selecting instruments, see
Instrument Discovery in the Wireless Test Bench Simulation documentation.

3. ESG_Start and ESG_Stop (when ESG_Bursts =0) specify when to start and
stop data collection. The number of samples collected,
ESG_Stop - ESG_Start + 1, must be in the range 60 samples to 64 Msamples,
where 1 Msample = 1,048,576 samples. The ESG requires an even number of
samples; the last sample will be discarded if ESG_Stop - ESG_Start + 1 is odd.

4. ESG_Bursts sets the number of bursts over which data will be collected. If
ESG_Bursts is greater than zero, then ESG_Stop is forced to
ESG_Start + ESG_Bursts x BurstTime where BurstTime is IdleTime +
ShortPreambleTime + LongPreambleTime + SIGNAL_Time + DataTime.

5. ESG_ClkRef specifies an internal or external reference for the ESG clock
generator. If set to External, the ESG_ExtClkRefFreq parameter sets the
frequency of this clock.

6. ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies
between the DAC output and the Dual Arbitrary Waveform Generator output
inside the ESG.

7. ESG_SampleClkRate sets the sample clock rate for the DAC output.

8. ESG_Filename sets the name of the waveform inside the ESG that will hold the
downloaded data.

9. The ESG driver expects data in the range {-1, 1}. If ESG_AutoScaling is set to
YES, inputs are scaled to the range {-1, 1}; if ESG_AutoScaling is set to NO, raw
simulation data is downloaded to the ESG without scaling, but data outside the
range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also applied to data
written to the local file (ESG_Filename setting).
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10. If ESG_ArbOn is set to YES, the ESG will start generating the signal
immediately after simulation data is downloaded; if set to NO, waveform
generation must be turned on at the ESG front panel.

11. If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately
after simulation data is downloaded. If ESG_RFPowOn is set to NO (default),
RF power must be turned on at the ESG front panel.

12. ESG_EventMarkerType specifies which ESG Event markers are enabled:
Event1, Event2, Both, or Neither. Event markers are used for synchronizing
other instruments to the ESG. When event markers are enabled, Event1 and/or
Event2 is set beginning from the first sample of the downloaded Arb waveform
over the range of points specified by the ESG_MarkerLength parameter. This is
equivalent to setting the corresponding event from the front panel of the ESG.

13. ESG_MarkerLength specifies the range of points over which the markers must
be set starting from the first point of the waveform. Depending on the setting of
ESG_EventMarkerType, the length of trigger Event1 or Event2 (or both) is set
to a multiple of the pulsewidth that, in turn, is determined by the sample clock
rate of the DAC output.

Simulation Measurement Displays
After running the simulation, results are displayed in Data Display pages for each
measurement activated.

Note Measurement results from a wireless test bench have associated names that can
be used in Data Display Expressions. For more information, refer to Appendix B,
Measurement Results for Expressions.

RF Envelope Measurement

The RF Envelope measurement (not defined in IEEE 802.11a) shows the envelope
time and spectrum of each field in the IEEE 802.11a RF signal burst (long preamble,
short preamble, SIGNAL, and DATA fields). Two signals are tested, the RF source
signal at the RF DUT input and the Meas signal at the RF DUT output.

From the RF signal, the basic signal burst information is given in Table 1-5.
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For the RF signal, the time domain envelope and envelope spectrum of one complete
burst of 11a are shown, as well as burst fields for short preamble, long preamble,
SIGNAL, and DATA in Figure 1-8 through Figure 1-17.

In Figure 1-8, the initial 4.0 µsec interval is the idle time when the transmitter sends
no signal, and follows the short preamble, long preamble, SIGNAL, and DATA fields.

Table 1-5. RF Signal Burst Parameters

Parameter Default Setting

RF_FSource 5200.0 MHz

RF_R 50.0 Ohm

BurstTime 40.0 usec

TimeStep 12.5 nsec

IdleTime 4.0 usec

LongPreambleTime 8.0 usec

ShortPreambleTime 8.0 usec

OFDM_SymbolTime 4.0 usec

DataTime 16.0 usec

SIGNAL_Time 4.0 usec
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Figure 1-8. Time Envelope of One Complete RF Signal Burst for Default Settings

Figure 1-9. Spectrum of IEEE 802.11a RF Signal
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Figure 1-10 shows the Short Preamble waveform which is 8.0 µsec. 12 subcarriers are
clearly visible as shown in Figure 1-11.

Figure 1-12 shows the Long Preamble waveform, which is also 8.0 µsec, lasting from
12.0 to 20.0 µsec. The spectrum is shown in Figure 1-13.

Figure 1-10. RF Signal Short Preamble Envelope

Figure 1-11. RF Signal Short Preamble Spectrum

Figure 1-12. RF Signal Long Preamble Envelope
1-34 Simulation Measurement Displays



Figure 1-13. RF Signal Long Preamble Spectrum

SIGNAL is 4.0 µsec lasting from 20.0 to 24.0 µsec (Figure 1-14). The spectrum is
shown in Figure 1-15.

Figure 1-14. RF Signal SIGNAL Envelope

Figure 1-15. RF Signal SIGNAL Spectrum
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DATA is 16.0 µsec lasting from 24.0 to 40.0 µsec (Figure 1-16). The spectrum is
shown in Figure 1-17.

Figure 1-16. RF Signal DATA Envelope

Figure 1-17. RF Signal DATA Spectrum
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For the Meas signal test, all measurements are the same as RF signal measurements,
except the Meas signal will contain any linear and nonlinear distortions, and time
envelope measurements will have the RF DUT time delay. Envelope and spectrum
measurements for Meas signal are shown in Figure 1-18 through Figure 1-27.

In Figure 1-18, Marker m1 must be set by the user to the start of the Short Preamble.
This will determine the RF DUT time delay that identifies where each Meas burst
structure begins and ends. The delay can be calculated by subtracting the idle time
from the time marked by m1; for example, in Figure 1-18
delay=6.075µsec-4.0µsec=2.075µsec. Because the mark may not accurately point to
the start position, the calculated delay may have some error.

Figure 1-18. Meas Signal Envelope for One Entire Burst

Figure 1-19. IEEE 802.11a Meas Signal Spectrum
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Figure 1-20 shows the Short Preamble of 8.0 µsec lasting from 6.0 to 14.0 µsec due to
a 2.0 µsec delay. 12 subcarriers of Short Preamble are shown in Figure 1-21.

Figure 1-22 shows the Long Preamble is also 8.0 µsec lasting from 14.0 to 22.0 µsec
due to a 2.0 µsec delay. The spectrum is shown in Figure 1-23.

Figure 1-24 shows SIGNAL is 4.0 µsec lasting from 22.0 to 26.0 µsec. The spectrum is
shown in Figure 1-25.

Figure 1-26 shows DATA is 16.0 µsec lasting from 26.0 to 42.0 µsec. The spectrum is
shown in Figure 1-27.

Figure 1-20. Meas Signal Short Preamble Envelope

Figure 1-21. Meas Signal Short Preamble Spectrum

Figure 1-22. Meas Signal Long Preamble Envelope
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Figure 1-23. Meas Signal Long Preamble Spectrum

Figure 1-24. Meas Signal SIGNAL Envelope

Figure 1-25. Meas Signal SIGNAL Spectrum

Figure 1-26. Meas Signal DATA Envelope
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Figure 1-27. Meas Signal DATA Spectrum
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Constellation Measurement

The constellation measurement (not defined in IEEE 802.11a) shows the RF and
Meas signal constellations.

In IEEE 802.11a, four types of modulation are implemented. Data rates and
modulation types are listed in Table 1-6. Basic signal information is listed in
Table 1-7.

A 54 Mbps data rate is used for this measurement; 64-QAM modulation results are
shown in Figure 1-28 and Figure 1-29; BPSK constellations for the SIGNAL field are
also shown.

Table 1-6. Data Rates and Modulation Types

Data Rate
(Mbits/s) Modulation

6 BPSK

9 BPSK

12 QPSK

18 QPSK

24 16-QAM

36 16-QAM

48 64-QAM

54 64-QAM

Table 1-7. Basic Constellation Measurement Parameters

Parameter Default Setting

RF_FSource 5200.0 MHz

RF_R 50.0 Ohm

DataTime 16.0 usec

BurstTime 40.0 usec

TimeStep 12.5 nsec

BitRate 54.0 Mbps

Meas_FMeasurement 5200.0 MHz

Meas_R 50.0 Ohm
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Figure 1-28. RF Signal Constellation

Figure 1-29. Meas Signal Constellation

BPSK

BPSK
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Power Measurement

The power measurement (not defined in IEEE 802.11a) shows the CCDF curves of
the transmitter and peak-to-average ratios for the RF and Meas signals.

The basic power measurement parameters are listed in Table 1-8.

CCDF measurement results for RF and Meas signals are shown in Figure 1-30 and
Figure 1-31.

Reference CCDF measurements for Gaussian noise can be calculated by calling the
function power_ccdf_ref() in the .dds files directly, as shown in Figure 1-32.

Functions for calculating peak-to-average-ratios and results are shown in
Figure 1-33 and Figure 1-34.

Table 1-8. Basic Power Measurement Parameters

Parameter Default Setting

RF_FSource 5200.0 MHz

RF_R 50.0 Ohm

Meas_FMeasurement 5200.0 MHz

Meas_R 50.0 Ohm

RF_Power_dBm 16.021 dBm
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Figure 1-30. RF Power CCDF

Gaussian
noise
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Figure 1-31. Meas Power CCDF

Figure 1-32. Reference CCDF Calculation

Figure 1-33. RF Signal Peak-to-Average-Ratio Calculation and Results

Figure 1-34. Meas Signal Peak-to-Average-Ratio Calculation and Results

Gaussian
noise
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Spectrum Measurement

The Spectrum measurement is used to verify that the transmitted spectrum meets
the spectrum mask according to IEEE 802.11a-1999, section 17.3.9.2. The
transmitted spectrum must have a 0 dBr (dB relative to the maximum spectral
density of the signal) bandwidth not exceeding 18 MHz (centered at the carrier
frequency), -20 dBr at 11 MHz frequency offset, -28 dBr at 20 MHz frequency offset,
and -40 dBr at 30 MHz frequency offset and above. The WLAN spectrum
measurement has a resolution bandwidth of 100 kHz. The transmitted spectral
density must fall within the spectral mask, as shown in Figure 1-35.

Figure 1-35. Transmit Spectrum Mask

Measurement results for RF and Meas signals are shown in Figure 1-36 and
Figure 1-37. The RF and Meas signal spectrums are within the spectrum mask and
therefore meet specification requirements.
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Figure 1-36. RF Signal Spectrum

Figure 1-37. Meas Signal Spectrum
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EVM Measurement

The EVM measurement is a modulation accuracy measurement and determines the
relative constellation RMS error (EVM) according to IEEE 802.11a-1999, section
17.3.9.6.3. The RMS error is averaged over subcarriers, OFDM frames, and packets;
results cannot exceed a data-rate-dependent value given in Table 1-9.

This measurement provides EVMrms_percent, EVM_dB, PilotEVM_dB,
CPErms_percent, IQ_Offset_dB, and so on.

PilotEVM is the RMS value of EVMs (in dB) of the four pilot subcarriers for all
symbols over the entire burst. For 802.11a this includes the SIGNAL symbol.
Common pilot error (CPE) shows the difference between the measured and ideal pilot
subcarrier symbols. SyncCorrelation is a cross correlation of the preamble
synchronization of the measured signal to an ideal signal; it is a figure of merit
indicating the quality of the preamble segment used for synchronization. The
preamble segment used to calculate the SyncCorrelation is either the short training
or the channel estimation sequence.

Basic parameters for this measurement are listed in Table 1-10.

Table 1-9. Allowed Relative Constellation Error Values

Data Rate
(Mbits/s)

Relative
Constellation
Error (dB)

EVM
(%RMS)

6 -5 56.2

9 -8 39.8

12 -10 31.6

18 -13 22.3

24 -16 15.8

36 -19 11.2

48 -22 7.9

54 -25 5.6

Note: The 27Mbps data rate is not defined in the
802.11a specification and is therefore not supported in
this measurement.

Table 1-10. Basic Signal Parameters

Parameter Default Setting

RF_FSource 5200.0MHz

RF_R 50.0Ohm
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EVM measurement results shown in Figure 1-38 and Figure 1-39 for the 54 Mbps
data rate do not exceed -25 dB; therefore the measurements meet the specification
requirements.

Figure 1-38. RF Signal EVM

Figure 1-39. Meas Signal EVM

Meas_FMeasurement 5200.0MHz

Meas_R 50.0Ohm

RF_Power_dBm 16.021dBm

BytesPerBurst 100

BitRate 54Mbps

OFDM_SymbolGuardInterval 0.25

TimeStep 12.5nsec

Table 1-10. Basic Signal Parameters (continued)

Parameter Default Setting
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Test Bench Variables for Data Displays

Reference variables used to set up this test bench are listed in Table 1-11 and
Table 1-12.

DataBitsPerOFDMSymbol and BitRate values are listed in Table 1-13.

Table 1-11. Test Bench Constants for WLAN Signal Setup

Constant Value

MinFFT_Size 64 (= 26)

BitsPerByte 8

ServiceBits 16

TailBits 6

Ratio Oversampling ratio related to the OversamplingOption as Ratio = 2OversamplingOption

DataBitsPerOFDMSymbol Dependent on DataRate

OFDMSymbolsPerBurst (int ((ServiceBits+BitsPerByte * DataLength+TailBits)/ DataBitsPerOFDMSymbol))+Tail

TailCondition ServiceBits+BitsPerByte * DataLength+TailBits - DataBitsPerOFDMSymbol

* (int ((ServiceBits+BitsPerByte * DataLength+TailBits)/ DataBitsPerOFDMSymbol))

Tail 0 if TailCondition=0, else 1

Table 1-12. Test Bench Equations Derived from
Test Bench Parameters and
Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(Bandwidth*Ratio)
This is the test bench simulation time step.

OFDM_SymbolTime MinFFT_Size*(1+GuardInterval)/Bandwidth
This is the time duration for one OFDM symbol.

OFDM_SymbolsPerBurst OFDMSymbolsPerBurst
This is the number of OFDM symbols in the Data field of a burst.

OFDM_SymbolGuardInterval GuardInterval
This is the guard interval (as a ratio of OFDM_SymbolTime) associated with each OFDM symbol.

IdleTime IdleInterval
This is the time duration of the zero level idle field at the front of each burst.

ShortPreambleTime 8.0 usec
This is the time duration of the short preamble field after the idle field in each burst.
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Baseline Performance
• Test Computer Configuration

• Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3

• Conditions

• Measurements made with default test bench settings.

LongPreambleTime 8.0 usec
This is the time duration of the long preamble field after the short preamble field in each burst.

SIGNAL_Time OFDM_SymbolTime
This is the time duration of the SIGNAL field after the long preamble field in each burst.

DataTime OFDM_SymbolsPerBurst*OFDM_SymbolTime
This is the time duration of the Data field after the SIGNAL field in each burst.

BurstTime IdleTime + ShortPreambleTime + LongPreambleTime + SIGNAL_Time + DataTime

BytesPerBurst DataLength
This is the number of bytes of data in the Data field in each burst.

BitRate Dependent on DataRate
This is the bit rate for the transmitted WLAN signal.

Meas_FMeasurement FMeasurement

Meas_R MeasR

Table 1-13. DataBitsPerOFDMSymbol and
BitRate Values

DataRate DataBitsPerOFDMSymbol BitRate)

Mbps_6 24 6e6

Mbps_9 36 9e6

Mbps_12 48 12e6

Mbps_18 72 18e6

Mbps_24 96 24e6

Mbps_27 108 27e6

Mbps_36 144 36e6

Mbps_48 192 48e6

Mbps_54 216 54e6

Table 1-12. Test Bench Equations Derived from
Test Bench Parameters and

Exported to Data Display (continued)

Data Display Parameter Equation with Test Bench Parameters
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• RF DUT is an RF system behavior component.

• Number of time points in one WLAN 802.11a burst is a function of
Bandwidth, OversamplingOption, IdleInterval, GuardInterval, DataRate,
and DataLength.

Bandwidth = 20 MHz
OversamplingOption = Option 2 for Ratio 4
IdleInterval = 4 µsec
GuardInterval = 0.25
DataRate = 54 Mbps
DataLength = 100

• Resultant WTB_TimeStep = 12.5 nsec; BurstTime = 40 µsec; time points per
burst = 3200

• Simulation times and memory requirements:

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench
and the RF DUT Circuit Envelope simulation with the same signal and number of
time points. For example, if the RF DUT performance with Circuit Envelope
simulation alone takes 2 hours and consumes 200 MB of memory (excluding the
memory consumed by the core ADS product), then add these numbers to the Baseline
Performance numbers to determine the expected ADS performance. This is valid only
if the full memory consumed is from RAM. If RAM is less, larger simulation times
may result due to increased disk access time for swap memory usage.

WLAN_802_11a_TX
Measurement

Bursts
Measured

Simulation
Time (sec) ADS Processes (MB)

RF_Envelope 3 10 58

Constellation 3 5 51

Power 3 4 50

Spectrum 3 4 50

EVM 10 13 53
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Chapter 2: WLAN 802.11b Transmitter Test

Introduction
WLAN_802_11b_TX is the test bench for WLAN transmitter testing. The test bench
provides a way for users to connect to an RF DUT and determine its performance by
activating various test bench measurements. This test bench provides signal
measurements for RF envelope, signal power (including CCDF), constellation,
spectrum, and EVM.

The signal and most of the measurements are designed according to the IEEE
Standard 802.11b-1999.

This signal source model is compatible with the Agilent Signal Studio Software
option 417 for transmitter test. Details regarding Signal Studio for WLAN 802.11 are
included at the website http://www.agilent.com/find/signalstudio.

The RF DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source
resistance, RF DUT connection, RF receivers, and DSP measurement blocks, as
illustrated in Figure 2-1. The generated test signal is sent to the DUT.

Figure 2-1. Transmitter Wireless Test Bench Block Diagram

The 802.11b baseband signal source frame structure is illustrated in Figure 2-2 and
Figure 2-3. Each frame is separated by an IdleInterval; one 802.11b frame consists of
PLCP Preamble, PLCP Header and Data (PSDU) parts. (PPDU means physical layer
protocol data units; SFD means start frame delimiter; CRC means cyclic redundancy
code; PLCP means physical layer convergence procedure; PSDU means PLCP service
data units.)

TX
DSP

RF Modulator RF Output
Resistance

RF
DUT

Meas RF
Receiver

Meas Signal DSP
Measurement

RF Receiver RF Signal DSP
Measurement

Q

I

WTB RF
Output

WTB Meas
Input

RF Load
Resistance
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Figure 2-2. Long PLCP Frame Format

Figure 2-3. Short PLCP Frame Format

The WLAN 11b RF power delivered into a matched load is the average power
delivered in the WLAN burst excluding the burst idle time. Figure 2-4 shows the RF
envelope for an output RF signal with 16 dBm power and a 10 µsec idle time.
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Figure 2-4. WLAN 802.11b RF Signal Envelope

Test Bench Basics
A template is provided for this test bench.

Figure 2-5. WLAN 802.11b Transmitter Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11b_TX_test, click OK;
click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click
File > Example Project > WLAN > WLAN_RF_Verification_prj >
WLAN_802_11b_TX_test.dsn.

The basics for using the test bench are:
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• Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

• CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your requirements.

• Activate/deactivate measurements based on your requirements.

• Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to “Test Bench Details” on page 2-4.

Test Bench Details
The following sections provide details for setting up a test bench, setting
measurement parameters for more control of the test bench, simulation
measurement displays, and baseline performance.

Open and use the WLAN_802_11b_TX template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11b_TX_test, click OK;
click left to place the template in the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

For information regarding using certain types of DUTs, see Appendix A, RF
DUT Limitations.

2. Set the Required Parameters

Note Refer to “WLAN_802_11b_TX” on page 2-8 for a complete list of
parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by
the user as needed.

• Set CE_TimeStep.

Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Agilent Circuit Envelope simulation
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technology). Each technology requires its own simulation time step with
time-step coordination occurring in the interface between the technologies.

CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings
WTB_TimeStep=1/(11.0e6*6) sec. The value is displayed in the Data Display
pages as TimeStep.

WTB_TimeStep = 1/(11.0e6 × Ratio)

where

11.0e6 means the baseband bandwidth of 11b is 11.0MHz.
Ratio is the OversamplingRatio value specified. OversamplingRatio sets the
number of waveform sampling points during one chip time interval.

• Set FSource, SourcePower, and FMeasurement.

• FSource defines the RF frequency for the signal input to the RF DUT. The
FSource value is exported to the Choosing Analyses window Fundamental
Tones field when the user clicks OK in the Wireless Test Bench Setup window.

• SourcePower defines the power level for FSource. SourcePower is defined as
the average power during the non-idle time of the signal burst.

• FMeasurement defines the RF frequency output from the DUT to be
measured.

3. Activate/deactivate (YES/NO) test bench measurements (refer to
“WLAN_802_11b_TX” on page 2-8). At least one measurement must be enabled:

• RF_EnvelopeMeasurement

• Constellation

• PowerMeasurement

• SpectrumMeasurement

• EVM_Measurement
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4. More control of the test bench can be achieved by setting Basic Parameters,
Signal Parameters, and parameters for each activated measurement. For
details, refer to “Setting Parameters” on page 2-13.

5. The RF modulator (shown in the block diagram in Figure 2-1) uses FSource,
SourcePower (Required Parameters), MirrorSourceSpectrum (Basic
Parameters), GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset,
and IQ_Rotation (Signal Parameters).

The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise
(Basic Parameters). The RF output signal source has a 50-ohm (default) output
resistance defined by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource),
with the specified source resistance (SourceR) and with power (SourcePower)
delivered into a matched load of resistance SourceR. The RF signal has additive
Gaussian noise power set by resistor temperature (SourceTemp) (when
EnableSourceNoise=YES).

Note that the Meas_in point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) (Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Figure 2-1) uses other Signal
Parameters.

6. More control of Circuit Envelope analysis can be achieved by setting Envelope
controller parameters. These settings include Enable AVM (Fast Cosim), which
may speed the RF DUT simulation more than 10×. Setting these simulation
options is described in Setting Automatic Verification Modeling Parameters and
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench
Simulation documentation.

7. To send the RF DUT output signal to an Agilent ESG RF signal generator, set
Signal to ESG Parameters.

For details, refer to “Signal to ESG Parameters” on page 2-30.

8. To run a simulation, choose Simulate > Simulate in the Schematic window.

For details on Running a Simulation refer to the Wireless Test Bench
Simulation documentation.
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9. Simulation results will appear in a Data Display window for each
measurement. “Simulation Measurement Displays” on page 2-32 describes
results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation
documentation.
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WLAN_802_11b_TX

This section provides parameter information for Required Parameters, Basic
Parameters, Signal Parameters, and parameters for the various measurements.

Parameters

Name Description Default Sym Unit Type Range

RequiredParameters

CE_TimeStep Circuit envelope simulation
time step

1/11 MHz/6 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/11e6/OversamplingRatio.
  OversamplingRatio is in
Signal Parameters tab.

FSource Source carrier frequency:
CH1_2412.0MHz,
CH3_2422.0MHz,
CH5_2432.0MHz,
CH6_2437.0MHz,
CH7_2442.0MHz,
CH9_2452.0MHz,
CH11_2462.0MHz,
CH13_2472.0MHz

CH1_2412.0MHz Hz real enum (0, ∞)

SourcePower Source power dbmtow(-20.0) W real [0, ∞)

FMeasurement Measurement carrier
frequency:
Meas_CH1_2412.0MHz,
Meas_CH3_2422.0MHz,
Meas_CH5_2432.0MHz,
Meas_CH6_2437.0MHz,
Meas_CH7_2442.0MHz,
Meas_CH9_2452.0MHz,
Meas_CH11_2462.0MHz,
Meas_CH13_2472.0MHz

Meas_CH1_2412
.0MHz

Hz real enum (0, ∞)

MeasurementInfo Available Measurements
  Each measurement has
parameters on its
tab/category below.

RF_EnvelopeMeasurement Enable RF envelope
measurement? NO, YES

YES enum
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Constellation Enable constellation
measurement? NO, YES

NO enum

PowerMeasurement Enable power
measurement? NO, YES

NO enum

SpectrumMeasurement Enable spectrum
measurement? NO, YES

NO enum

EVM_Measurement Enable EVM
measurement? NO, YES

NO enum

BasicParameters

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor
temperature

-273.15 Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO enum

MeasR Measurement resistance 50 Ohm Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO enum

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO enum

RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO enum

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO enum

TestBenchSeed Random number generator
seed

1234567 int [0, ∞)

SignalParameters

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0 real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0 real (-∞, ∞)

IQ_Rotation IQ rotation 0.0 deg real (-∞, ∞)

OversamplingRatio Oversampling ratio 6  S int [2, 9]

DataRate Data rate (Mbps): Mpbs_1,
Mbps_2, Mbps_5.5,
Mbps_11

Mbps_11  R enum

Modulation Modulation format: CCK,
PBCC

CCK enum

PreambleFormat Preamble/header format:
Long, Short

Long  H enum

Name Description Default Sym Unit Type Range
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ClkLockedFlag Lock header clock? NO,
YES

YES enum

PwrRamp RF power ramp shape:
None, Linear, Cosine

Linear  P enum

IdleInterval Burst idle interval 10.0 usec  I sec real [0, 1000us]

FilterType Shaping filter type:
NoneFilter, Gaussian, Root
Cosine, Ideal Lowpass

Gaussian enum

RRC_Alpha RRC roll-off factor 0.22 real (0.0, 1.0]

GaussianFilter_bT Gaussian filter bT
coefficient

0.5 real (0.0, 1.0]

FilterLength Filter length (chips) 10 int [1, 200]

DataType Payload data type: PN9,
PN15, FIX4, _4_1_4_0,
_8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9 enum

DataLength Data length (bytes per
burst)

160  L int [1, 2312]

RF_EnvelopeMeasurementParam
eters

RF_EnvelopeDisplayPages RF Envelope
measurement display
pages:
  WLAN_802_11b_TX
Envelope  Figures

RF_EnvelopeStart RF envelope measurement
start

0.0 sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

100.0 usec sec real [RF_EnvelopeSt

art, ∞)

RF_EnvelopeBursts RF envelope measurement
bursts

3 int [0, 100]

ConstellationParameters

ConstellationDisplayPages Constellation
measurement display
pages:
  WLAN_802_11b_TX
Constellation Figures

Constellation_ForwardTaps Number of equalizer
forward taps

6 int [1, 256]

Constellation_FeedbackTaps Number of equalizer
feedback taps

3 int [1, 128]

Constellation_EquAlpha LMS algorithm scale factor 0.001 real (0, 1.0)

ConstellationStartBurst Constellation
measurement start burst

0 int [0, 100]

Name Description Default Sym Unit Type Range
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ConstellationBursts Constellation
measurement bursts

3 int [1, 100]

PowerMeasurementParameters

PowerDisplayPages Power measurement
display pages:
  WLAN_802_11b_TX
Power
Figures/Tables/Equations

PowerBursts Power measurement
bursts

3 int [1, 100]

SpectrumMeasurementParameter
s

SpectrumDisplayPages Spectrum  measurement
display pages:
  WLAN_802_11b_TX
Spectrum Equations
  WLAN_802_11b_TX
Spectrum Figures/Tables

SpecMeasStart Spectrum measurement
start

0.0 sec real [0, ∞)

SpecMeasStop Spectrum measurement
stop

100.0 usec sec real [SpecMeasStart
+
16*MaxTimeSte

p, ∞]

SpecMeasBursts Spectrum measurement
bursts

3 int [0, 100]

SpecMeasResBW Spectrum resolution
bandwidth

100 kHz Hz real [0, ∞)

SpecMeasWindow Window type: none,
Hamming 0.54, Hanning
0.50, Gaussian 0.75,
Kaiser 7.865, _8510 6.0,
Blackman,
Blackman-Harris

Kaiser 7.865 enum

EVM_MeasurementParameters

EVM_DisplayPages EVM measurement display
pages:
  WLAN_802_11b_TX
EVM Tables/Figures

EVM_Start EVM measurement start 0.0 sec real [0, ∞)

EVM_AverageType Average type: Off, RMS
(Video)

RMS (Video) enum

EVM_BurstsToAverage Bursts used for RMS
averaging

10 int [1, ∞)

Name Description Default Sym Unit Type Range
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EVM_DataModulationFormat Data subcarrier modulation
format: Auto Detect, Barker
1, Barker 2, CCK 5.5, CCK
11, PBCC 5.5, PBCC 11,
PBCC 22, PBCC 33

Auto Detect enum

EVM_SearchLength Search length 0.001 sec real (0, ∞)

EVM_ResultLengthType Resul length type: Auto
select, Manual Override

Auto select enum

EVM_ResultLength Max result length (chips) 2816 int [1, 108344]

EVM_MeasurementInterval Measurement interval
(chips)

2794 int [1, ∞)

EVM_MeasurementOffset Measurement offset
(chips)

22 int (0, ∞)

EVM_ClockAdjust Clock adjustment interval
(chips)

0.0 real [-0.5, +0.5]

EVM_EqualizationFilter Equalization filter? NO,
YES

NO enum

EVM_FilterLength Equalization filter length
(chips)

21 int [3, ∞)

EVM_DescrambleMode Descramble mode: OFF,
Preamble Only,
Preamble&Header Only,
ON

ON enum

SignalToESG_Parameters

EnableESG Enable signal to ESG? NO,
YES

NO enum

ESG_Instrument ESG instrument address [GPIB0::19::INST
R][localhost][4790
]

instrument

ESG_Start Signal start 0.0 sec real [0, ∞)

ESG_Stop Signal stop 100.0 usec sec real [(ESG_Start+60
/11e6/S),
(ESG_Start+32/
11/S)]

ESG_Bursts Bursts to ESG 3 int [0, 1000]

ESG_Power ESG RF ouput power
(dBm)

-20.0 real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal enum

ESG_ExtClkRefFreq External clock reference
freq

10 MHz Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz,
filter_40MHz

through enum

Name Description Default Sym Unit Type Range
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Pin Inputs

Pin Outputs

Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note For required parameter information, see “Set the Required Parameters” on
page 2-4.

Basic Parameter Detail

1. SourceR is the RF output source resistance.

ESG_SampleClkRate Sequencer sample clock
rate

80 MHz Hz real (0, ∞)

ESG_Filename ESG waveform storage
filename

WLAN_11b string

ESG_AutoScaling Activate auto scaling? NO,
YES

YES enum

ESG_ArbOn Select waveform and turn
ArbOn after download?
NO, YES

YES enum

ESG_RFPowOn Turn RF ON after
download? NO, YES

YES enum

ESG_EventMarkerType Event marker type: Neither,
Event1, Event2, Both

Event1 enum

ESG_MarkerLength ESG marker length 10 int [1, 60]

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

Pin Name Description

1 RF_Out Test bench RF output to RF circuit

Name Description Default Sym Unit Type Range
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2. SourceTemp is the RF output source resistance temperature (oC) and sets noise
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k
is Boltzmann’s constant.

3. EnableSourceNoise, when set to NO disables the SourceTemp and effectively

sets it to -273.15oC (0 Kelvin). When set to YES, the noise density due to
SourceTemp is enabled.

4. MeasR defines the load resistance for the RF DUT output Meas signal into the
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for Meas signal power measurements.

5. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the
generated RF signal before it is sent to the RF DUT. Depending on the
configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set
this parameter to YES.

6. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the
Meas_in RF signal input to the test bench (and output from the RF DUT).
Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the
signal source (before any mirroring is done because of the
MirrorSourceSpectrum setting). Proper demodulation and measurement of the
RF DUT output signal requires that its RF envelope is not mirrored compared
to the signal generated by the signal source (before any mirroring is done
because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is
required for measurements on the Meas_in signal in TX test benches (EVM,
Constellation, CDP, PCDE) and results in measurement on a signal with no
spectrum mirroring.

7. TestBenchSeed is an integer used to seed the random number generator used
with the test bench. This value is used by all test bench random number
generators, except those RF DUT components that use their own specific seed
parameter. TestBenchSeed initializes the random number generation. The
same seed value produces the same random results, thereby giving you
predictable simulation results. To generate repeatable random output from
simulation to simulation, use any positive seed value. If you want the output to
be truly random, enter the seed value of 0.
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8. RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out
RF signal for RF envelope, ppectrum, ACLR, and occupied bandwidth
measurements. RF_MirrorFreq is typically set by the user to NO when
MirrorSourceSpectrum = NO; RF_MirrorFreq is typically set by the user to
YES when MirrorSourceSpectrum = YES. Both settings result in viewing the
RF_out signal with no spectrum mirroring. Other settings by the user result in
RF_out signal for RF_Envelope and Spectrum measurements with spectrum
mirroring.

9. MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in
RF signal for the RF envelope, spectrum, ACLR, and occupied bandwidth
measurements.

MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT
results in no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is
typically set to YES by the user when the combination of the
MirrorSourceSpectrum and RF DUT results in spectrum mirroring in the
Meas_in signal.

Other settings result in Meas_in signal for RF_Envelope and Spectrum
measurements with spectrum mirroring. The MirrorMeasSpectrum parameter
setting has no impact on the setting or use of the MeasMirrorFreq parameter.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and
IQ_Rotation are used to add certain impairments to the ideal output RF signal.
Impairments are added in the order described here.

The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI(t) is the in-phase RF envelope, VQ(t) is the
quadrature phase RF envelope, g is the gain imbalance

V RF t( ) A V I t( ) ωct( )cos gVQ t( ) ωct
φπ
180
---------+ 

 sin– 
 =
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and, φ (in degrees) is the phase imbalance.

Next, the signal VRF(t) is rotated by IQ_Rotation degrees. The I_OriginOffset
and Q_OriginOffset are then applied to the rotated signal. Note that the
amounts specified are percentages with respect to the output rms voltage. The
output rms voltage is given by sqrt(2 × SourceR × SourcePower).

2. OversamplingRatio sets the oversampling ratio of 802.11b RF signal source.
Eight oversampling ratios (2, 3, 4, 5, 6, 7, 8, 9) are supported. If
OversamplingRatio=4, the simulation RF bandwidth is larger than the signal
bandwidth by a factor of 4 (e.g. for Bandwidth=11 MHz, the simulation RF
bandwidth=11 MHz × 4 = 44 MHz).

3. DataRate specifies the data rate 1, 2, 5.5, or 11 Mbps (data rates are defined in
802.11b).

4. Modulation specifies modulation format CCK or PBCC (802.11b formats) for 5.5
Mbps and 11 Mbps data rates.

5. PreambleFormat is used to set the format of the framed signal preamble/header
sections; refer to Figure 2-2 and Figure 2-3.

6. ClkLockedFlag is used to toggle the clock locked flag in the header. This is Bit 2
in the Service field of the PPDU frame. This bit is used to indicate to the
receiver if the carrier and the symbol clock use the same local oscillator. If
ClkLockedFlag=YES, this bit is set to 1; if ClkLockedFlag=NO, this bit is set to
0.

7. PwrRamp is used to select the shape of the RF burst in framed mode; power
up/down ramp type is none, linear, or cosine.

• Cosine ramp gives least amount of out-of-channel interference.

• None starts transmitting the signal at full power, and is the simplest power
ramp to implement. The power up/down ramp is set to 2 µsec when PwrRamp
= none.

• Linear ramp shapes the burst in a linear fashion.

8. IdleInterval sets an idle time between two consecutive bursts when generating
the 802.11b signal source.

g 10

GainImbalance
20

-----------------------------------------------

=
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9. FilterType is used to specify that a baseband filter is applied to reduce the
transmitted bandwidth, thereby increasing spectral efficiency. The 802.11b
specification does not indicate the type of filter to be used, but the transmitted
signal must meet the spectral mask requirements. Four options for baseband
filtering are available:

• None (no filter)

• Gaussian The Gaussian filter does not have zero ISI. Wireless system
architects must determine how much of the ISI can be tolerated in a system
and combine that with noise and interference. The Gaussian filter is
Gaussian-shaped in time and frequency domains, and it does not ring as root
cosine filters do.

The effects of this filter in the time domain are relatively short and each
symbol interacts significantly (or causes ISI) with only the preceding and
succeeding symbols. This reduces the tendency for particular sequences of
symbols to interact which makes amplifiers easier to build and more efficient.

• Root Cosine (also referred to as square root raised-cosine) These filters have
the property that their impulse response rings at the symbol rate. Adjacent
symbols do not interfere with each other at the symbol times because the
response equals zero at all symbol times except the center (desired) one.

Root cosine filters heavily filter the signal without blurring the symbols
together at the symbol times. This is important for transmitting information
without errors caused by ISI. Note that ISI exists at all times except at
symbol (decision) times.

• Ideal Lowpass  In the frequency domain, this filter appears as a lowpass,
rectangular filter with very steep cut-off characteristics. The passband is set
to equal the symbol rate of the signal. Due to a finite number of coefficients,
the filter has a predefined length and is not truly ideal. The resulting ripple
in the cut-off band is effectively minimized with a Hamming window. A
symbol length of 32 or greater is recommended for this filter.

10. RRC_Alpha is used to set the sharpness of a root cosine filter when
FilterType=Root Cosine.

11. GaussianFilter_bT is the Gaussian filter coefficient. B is the 3 dB bandwidth of
the filter; T is the duration of the symbol period. BT determines the extent of
the filtering of the signal. Common values for BT are 0.3 to 0.5.
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12. FilterLength is used to set the number of symbol periods to be used in the
calculation of the symbol.

13. For DataType:

• if PN9 is selected, a 511-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.153

• if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151

• if FIX4 is selected, a zero-stream is generated

• if x_1_x_0 is selected, where x equals 4, 8, 16, 32, or 64, a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s
and the second x bits are 0s.

14. DataLength is used to set the number of data bytes in a frame.

RF Envelope Measurement Parameters

The RF Envelope measurement is not affected by the MirrorMeasSpectrum
parameter. To apply spectrum mirroring to the measured RF_out signal, set
RF_MirrorFreq=YES; to apply spectrum mirroring to the measured Meas_in signal,
set MeasMirrorFreq=YES (Basic Parameters).

• RF_EnvelopeDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

• RF_EnvelopeStart sets the start time for collecting input data.

• RF_EnvelopeStop sets the stop time for collecting input data when
RF_EnvelopeBursts = 0.

• RF_EnvelopeBursts (when > 0) sets the number of bursts over which data will
be collected.

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and
RF_EnvelopeBursts, the stop time may be adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:

Start = TimeStep× (int(RF_EnvelopeStart/TimeStep) + 0.5)

Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)
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This means Start and Stop are forced to be an integer number of time-step
intervals.

For the RF envelope of Meas_in to contain at least one complete burst, set the Stop
value to a minimum of BurstTime + (RF DUT time delay).

For the RF envelope of Meas_in to contain at least one complete burst, the Stop value
should be set to a minimum of BurstTime + (RF DUT time delay).

For information about TimeStep and BurstTime, see Table 2-11.

RF_EnvelopeBursts Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeBursts x BurstTime
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Constellation Parameters

The Constellation measurement requires setting of the MirrorMeasSpectrum
parameter set such that there is an even number of spectrum mirrorings from the
combined test bench source and RF DUT. For example, if MirrorSourceSpectrum=NO
and the RF DUT causes its output RF signal to have spectrum mirroring relative to
its input signal, then set MirrorMeasSpectrum = YES.

1. ConstellationDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

2. Constellation_ForwardTaps sets the number of forward taps for the decision
feedback equalizer in 802.11b.

3. Constellation_FeedbackTaps sets the number of feedback taps for the decision
feedback equalizer in 802.11b.

4. Constellation_EquAlpha sets the feedback taps scale factor for the decision
feedback equalizer, which determines the convergence speed of the DFE in the
802.11b receiver.

5. ConstellationStartBurst sets the start time for collecting the first burst data.
The ConstellationStartBurst value can be set > 0 to avoid any start-up
transient in the Constellation plots.

6. ConstellationBursts sets the number of bursts over which data will be collected.

The measurement start time is the time when ConstellationStartBurst is detected in
the measured RF signal. The measurement stop time is this start time plus
ConstellationBursts × BurstTime; BurstTime is defined in Table 2-11.

Power Measurement Parameters

1. PowerDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.

2. PowerBursts (when > 0) sets the number of bursts over which data will be
collected.

The measurement start time is the time when the first burst is detected in the
measured RF signal. The measurement stop time is this start time plus PowerBursts
× BurstTime; BurstTime is defined in Table 2-11.
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Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging
the spectrum over multiple bursts can be enabled as described in this section.

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES; to
apply spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq =
YES.

In the following, TimeStep denotes the simulation time step, and FMeasurement
denotes the measured RF signal characterization frequency.

1. The measurement outputs the complex amplitude voltage values at the
frequencies of the spectral tones. It does not output the power at the frequencies
of the spectral tones. However, one can calculate and display the power
spectrum as well as the magnitude and phase spectrum by using the dBm, mag,
and phase functions of the data display window.

Note that the dBm function assumes a 50-ohm reference resistance; if a
different measurement was used in the test bench, its value can be specified as
a second argument to the dBm function, for example, dBm(SpecMeas,
Meas_RefR) where SpecMeas is the instance name of the spectrum
measurement and Meas_RefR is the resistive load.

By default, the displayed spectrum extends from
FMeasurement - 1/(2 × TimeStep) Hz to FMeasurement + 1/(2 × TimeStep) Hz.
When FMeasurement < 1/(2 × TimeStep), the default spectrum extends to
negative frequencies. The spectral content at these negative frequencies is
conjugated, mirrored, and added to the spectral content of the closest positive
frequency. This way, the negative frequency tones are displayed on the positive
frequency axis as would happen in an RF spectrum analyzer measurement
instrument. This process may introduce an error in the displayed frequency for
the mirrored tones. The absolute error introduced is less than
(Spectrum Frequency Step) / 2 (see Table 2-1 for the definition of Spectrum
Frequency Step).

The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple bursts and average the results to
achieve video averaging (see note 6).

2. SpectrumDisplayPages is not user editable. It provides information on the
name of the Data Display pages in which this measurement is contained.
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3. SpecMeasStart sets the start time for collecting input data.

4. SpecMeasStop sets the stop time for collecting input data when
SpecMeasBursts = 0 and SpecMeasResBW = 0.

5. SpecMeasBursts sets the number of bursts over which data will be collected
when SpecMeasBursts>0.

6. SpecMeasResBW sets the resolution bandwidth of the spectrum measurement
when SpecMeasResBW>0.

Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasBursts,
and SpecMeasResBW, the stop time may be adjusted or spectrum video
averaging may occur (or both). The different cases are described in Table 2-1.

Referring to Table 2-1 let

Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)

Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)

(This means Start and Stop are forced to be an integer number of time step
intervals.)

X = normalized equivalent noise bandwidth of the window

Equivalent noise bandwidth (ENBW) compares the window to an ideal,
rectangular filter. It is the equivalent width of a rectangular filter that passes
the same amount of white noise as the window. The normalized ENBW
(NENBW) is ENBW multiplied by the duration of the signal being windowed.
Table 2-2 lists the NENBW for the various window options.

The Start and Stop times are used for both the RF_out and Meas_in signal
spectrum analyses. The Meas_in signal is delayed in time from the RF_out
signal by the value of the RF DUT time delay. Therefore, for RF DUT time delay
greater than zero, the RF_out and Meas_in signal are inherently different and
some spectrum display difference in the two is expected.

TimeStep and BurstTime are defined in the Test Bench Variables for Data
Displays section.
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Table 2-1. Effect of Values for
SpecMeasStart, SpecMeasStop, SpecMeasBursts, and SpecMeasResBW

Case 1 SpecMeasBursts = 0
SpecMeasResBW = 0

Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case 2 SpecMeasBursts > 0
SpecMeasResBW = 0

Resultant stop time = Start + SpecMeasBurst x BurstTime
Notes: For SpecMeasBursts > 0 and SpecMeasResBW = 0
- Video averaging occurs over all burst time intervals

Resultant resolution BW = X /BurstTime
Resultant spectrum frequency step = 1/BurstTime
Video averaging status = Yes, when SpecMeasBursts > 1

Case 3 SpecMeasBursts = 0
SpecMeasResBW > 0

Resultant stop time = Start + N x BurstTimeInterval
where
N = int((Stop -Start)/BurstTimeInterval) + 1

For SpecMeasBursts = 0 and SpecMeasResBW > 0
Define BurstTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means BurstTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (N) of BurstTimeIntervals
N has a minimum value of 1
Video averaging occurs over all BurstTimeIntervals
The resolution bandwidth achieved is ResBW = X / BurstTimeInterval, which is very close to SpecMeasResBW but may
not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case 4 SpecMeasBursts > 0
SpecMeasResBW > 0

Resultant stop time = Start + M x BurstTimeInterval
where

M = int((SpecMeasBursts x BurstTime)/BurstTimeInterval) + 1

For SpecMeasBursts > 0 and SpecMeasResBW > 0
Define BurstTimeInterval = TimeStep x int(( X /SpecMeasResBW/TimeStep) + 0.5)
This means BurstTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (M) of the BurstTimeIntervals
M has a minimum value of 1
Video averaging occurs over all BurstTimeIntervals
The resolution bandwidth achieved is ResBW = X / BurstTimeInterval, which is very close to SpecMeasResBW but may
not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1
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7. SpecMeasWindow specifies the window that will be applied to each burst before
its spectrum is calculated. Different windows have different properties, affect
the resolution bandwidth achieved, and affect the spectral shape. Windowing is
often necessary in transform-based (chirp-Z, FFT) spectrum estimation in order
to reduce spectral distortion due to discontinuous or non-harmonic signal over
the measurement time interval. Without windowing, the estimated spectrum
may suffer from spectral leakage that can cause misleading measurements or
masking of weak signal spectral detail by spurious artifacts.

The windowing of a signal in time has the effect of changing its power. The
spectrum measurement compensates for this and the spectrum is normalized so
that the power contained in it is the same as the power of the input signal.

Window Type Definitions:

• none:

where N is the window size

• Hamming 0.54:

where N is the window size

• Hanning 0.5:

where N is the window size

• Gaussian 0.75:
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where N is the window size

• Kaiser 7.865:

where N is the window size, α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind

• 8510 6.0 (Kaiser 6.0):

where N is the window size, α = N / 2, and I0(.) is the 0th order modified
Bessel function of the first kind

• Blackman:

where N is the window size

• Blackman-Harris:

where N is the window size.
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EVM Measurement Parameters

This measurement requires setting of the MirrorMeasSpectrum parameter such that
there is an even number of spectrum mirrorings from the combined test bench source
and RF DUT. For example, if MirrorSourceSpectrum = NO and the RF DUT causes
its output RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum = YES.

This measurement provides results for:

• Avg_WLAN_80211b_1000_chip_Pk_EVM_pct: average EVM in percentage as
specified by the standard (section 18.4.7.8 Transmit modulation accuracy in
802.11b specification; pages 55-57) except that the EVM value is normalized

• WLAN_80211b_1000_chip_Pk_EVM_pct: EVM in percentage as specified by
the standard (section 18.4.7.8 Transmit modulation accuracy in 802.11b
specification; pages 55-57) with the exception that the EVM value is normalized
versus burst

• Avg_EVMrms_pct: average EVM rms in percentage as defined in the Agilent
89600 VSA

• EVMrms_pct: EVM rms in percentage as defined in the Agilent 89600 VSA
versus burst

• EVM_Pk_pct: peak EVM in percentage versus burst

• EVM_Pk_chip_idx: peak EVM chip index versus burst

• Avg_MagErr_rms_pct: average magnitude error rms in percentage

• MagErr_rms_pct: magnitude error rms in percentage versus burst

Table 2-2. Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021
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• MagErr_Pk_pct: peak magnitude error in percentage versus burst

• MagErr_Pk_chip_idx: peak magnitude error chip index versus burst

• Avg_PhaseErr_deg: average phase error in degrees

• PhaseErr_deg: phase error in degrees versus burst

• PhaseErr_Pk_deg: peak phase error in degrees versus burst

• PhaseErr_Pk_chip_idx: peak phase error chip index versus burst

• Avg_FreqError_Hz: average frequency error in Hz

• FreqError_Hz: frequency error in Hz versus burst

• Avg_IQ_Offset_dB: average IQ offset in dB

• IQ_Offset_dB: IQ offset in dB versus burst

• Avg_SyncCorrelation: average sync correlation

• SyncCorrelation: sync correlation versus burst

Results named Avg_ are averaged over the number of bursts specified by the user (if
AverageType is set to RMS (Video)). Results that are not named Avg_ are results
versus burst.

Algorithm and Parameter Information

1. EVM_DisplayPages provides Data Display page information. It is not user
editable.

2. Starting at the time instant specified by EVM_Start, a signal segment of length
EVM_SearchLength is captured. This signal segment is searched in order for a
complete burst to be detected. The burst search algorithm looks for both a burst
on and a burst off transition. In order for the burst search algorithm to detect a
burst, an idle part must exist between consecutive bursts and the bursts must
be at least 15 dB above the noise floor.

EVM_Start time is used for both the RF_out and Meas_in EVM analyses. The
Meas_in signal is delayed in time from the RF_out signal by the value of the RF
DUT time delay. Thus for RF DUT time delay greater than zero, the RF_out and
Meas_in signal are inherently different and some EVM difference in the two is
expected even if the RF DUT does not introduce any distortion except for time
delay.
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If the captured signal segment does not contain a complete burst, the algorithm
will not detect any burst and the analysis that follows will most likely produce
the wrong results. Therefore, EVM_SearchLength must be long enough to
capture at least one complete burst. Since the time instant specified by the
EVM_Start parameter can be a little after the beginning of a burst, it is
strongly recommended that EVM_SearchLength is set to a value approximately
equal to 2 x BurstTime + 3 x Idle, where BurstTime is the duration of a burst
and Idle is the duration of the idle part. If it is known that EVM_Start is close
to the beginning of a burst then EVM_SearchLength can be set to BurstTime +
2 x Idle. If the duration of the burst or the idle part is unknown, then the RF
envelope of the signal can be plotted and these durations determined by
observing the plot.

After a burst is detected, the I and Q envelopes of the input signal are
extracted. In the RF_out (Meas_in) EVM analysis, the FSource
(FMeasurement) parameter sets the frequency of the internal local oscillator
signal for the I and Q envelope extraction. Then synchronization is performed
based on the preamble. Finally, the burst is demodulated and analyzed to get
the EVM measurement results.

3. If EVM_AverageType is set to Off, only one pulse is detected, demodulated, and
analyzed.

If EVM_AverageType is set to RMS (Video), after the first pulse is analyzed the
signal segment corresponding to it is discarded and new signal samples are
collected from the input to fill in the signal buffer of length
EVM_SearchLength. When the buffer is full again a new pulse search is
performed and when a pulse is detected it is demodulated and analyzed. These
steps are repeated until EVM_BurstsToAverage pulses are processed.

If for any reason a pulse is misdetected the results from its analysis are
discarded. The EVM results obtained from all the successfully detected,
demodulated, and analyzed pulses are averaged to give the final averaged
results. The EVM results from each successfully analyzed pulse are also
recorded (in the variables without the “Avg_” prefix in their name).

4. EVM_DataModulationFormat allows the user to specify the modulation format
used in the PSDU part of the burst. If EVM_DataModulationFormat is set to
Auto Detect, the algorithm will use the information detected in the PLCP
header part of the burst to automatically determine the modulation format.
Otherwise, the modulation format determined from the PLCP header is ignored
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and the modulation format specified by the EVM_DataModulationFormat
parameter is used in the demodulation of the PSDU part of the burst.

5. EVM_ResultLengthType and EVM_ResultLength control how much data is
acquired and demodulated.

• When EVM_ResultLengthType is set to Auto Select, the measurement result
length is automatically determined from the information in the PLCP header
part of the burst. In this case, the EVM_ResultLength defines a maximum
result length for the burst in chips; that is, if the measurement result length
that is automatically detected is larger than EVM_ResultLength it will be
truncated to EVM_ResultLength. The maximum result length specified by
EVM_ResultLength includes the PLCP preamble and PLCP header.

• When EVM_ResultLengthType is set to Manual Override, the measurement
result length is set to EVM_ResultLength regardless of what is detected in
the PLCP header part of the burst. The result length specified by
EVM_ResultLength includes the PLCP preamble and PLCP header.

Table 2-3 lists measurement result lengths actually used based on Auto Select
and Manual Override modes for different EVM_ResultLength values; an input
burst of 2816 chips is assumed.

Note that when EVM_ResultLengthType=Manual Override and
EVM_ResultLength=3300 (greater than the actual burst size) the algorithm
will demodulate the full 3300 chips even though this is 484 chips beyond the
pulse width.

6. With the EVM_MeasurementInterval and EVM_MeasurementOffset
parameters the user can isolate a specific segment of the EVM_ResultLength
for analysis. Only the segment specified by these two parameters will be
analyzed in order to determine the EVM results. The values of

Table 2-3. EVM_ResultLength Settings

EVM_ResultLengthType EVM_ResultLength
Measurement Result
Length Actually Used

Auto Select 2200 2200

Auto Select 2816 2816

Auto Select 3300 2816

Manual Override 2200 2200

Manual Override 2816 2816

Manual Override 3300 3300
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EVM_MeasurementInterval and EVM_MeasurementOffset are in number of
chips and are relative to the ideal starting point of the PLCP preamble portion
of the burst. For a signal that uses the long PLCP format, the ideal starting
point of the PLCP preamble is exactly 128 symbol times (128×11 chips) before
the start of the SFD sync pattern. For a signal that uses the short PLCP format,
the ideal starting point of the PLCP preamble is exactly 56 symbol times (56×11
chips) before the start of the SFD sync pattern.

7. Although the algorithm synchronizes to the chip timing of the signal, it is
possible for the synchronization to be slightly off. EVM_ClockAdjust allows the
user to specify a timing offset which is added to the chip timing detected by the
algorithm; EVM_ClockAdjust should be used only when trying to debug
unusual signals.

8. EVM_EqualizationFilter and EVM_FilterLength define whether an
equalization filter will be used or not and what the filter length (in number of
chips) should be. An equalization filter can dramatically improve EVM results
because the equalizer can compensate for ISI caused by the transmit filter. An
equalization filter can also compensate for distortion introduced by the DUT. If
the filter used in the transmitter is Gaussian, then a Gaussian filter with the
same BT is automatically used as a reference filter for EVM analysis. In this
case, turning the equalizer off will give a more accurate measure of distortion
caused by the DUT.

Signal to ESG Parameters

The EVM measurement collects Meas_in signal data and downloads it to an Agilent
E4438C Vector Signal Generator. Connection Manager architecture isused to
communicate with the instrument; parameters specify how data is interpreted.

Prerequisites for using the Signal to ESG option are:

• ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg.

• PC workstation running an instance of the connection manager server.

• Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager.

• AgilentRfSigGen IVI-COM driver installed on the PC running the connection
manager server. This driver installation is made available as an option during
the connection manager server installation.
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Parameter Information

1. EnableESG specifies if the signal is downloaded to the ESG instrument. If set
to NO, no attempt will be made to communicate with the instrument.

2. ESG_Instrument specifies a triplet that identifies the VSA resource of the
instrument to be used in the simulation, the connection manager server
hostname (defaults to localhost), and the port at which the connection manager
server listens for incoming requests (defaults to 4790). To ensure that this field
is populated correctly, click Select Instrument, enter the server hostname and
port, click OK to see the Remote Instrument Explorer dialog, select a VSA
resource identifier, and click OK. For details about selecting instruments, see
Instrument Discovery in the Wireless Test Bench Simulation documentation.

3. ESG_Start and ESG_Stop (when ESG_Bursts =0) specify when to start and
stop data collection. The number of samples collected,
ESG_Stop - ESG_Start + 1, must be in the range 60 samples to 64 Msamples,
where 1 Msample = 1,048,576 samples. The ESG requires an even number of
samples; the last sample will be discarded if ESG_Stop - ESG_Start + 1 is odd.

4. ESG_Bursts sets the number of bursts over which data will be collected. If
ESG_Bursts is greater than zero, then ESG_Stop is forced to
ESG_Start + ESG_Bursts x BurstTime where BurstTime is IdleTime +
ShortPreambleTime + LongPreambleTime + SIGNAL_Time + DataTime.

5. ESG_ClkRef specifies an internal or external reference for the ESG clock
generator. If set to External, the ESG_ExtClkRefFreq parameter sets the
frequency of this clock.

6. ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies
between the DAC output and the Dual Arbitrary Waveform Generator output
inside the ESG.

7. ESG_SampleClkRate sets the sample clock rate for the DAC output.

8. ESG_Filename sets the name of the waveform inside the ESG that will hold the
downloaded data.

9. The ESG driver expects data in the range {-1, 1}. If ESG_AutoScaling is set to
YES, inputs are scaled to the range {-1, 1}; if ESG_AutoScaling is set to NO, raw
simulation data is downloaded to the ESG without scaling, but data outside the
range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also applied to data
written to the local file (ESG_Filename setting).
Setting Parameters 2-31



WLAN 802.11b Transmitter Test
10. If ESG_ArbOn is set to YES, the ESG will start generating the signal
immediately after simulation data is downloaded; if set to NO, waveform
generation must be turned on at the ESG front panel.

11. If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately
after simulation data is downloaded. If ESG_RFPowOn is set to NO (default),
RF power must be turned on at the ESG front panel.

12. ESG_EventMarkerType specifies which ESG Event markers are enabled:
Event1, Event2, Both, or Neither. Event markers are used for synchronizing
other instruments to the ESG. When event markers are enabled, Event1 and/or
Event2 is set beginning from the first sample of the downloaded Arb waveform
over the range of points specified by the ESG_MarkerLength parameter. This is
equivalent to setting the corresponding event from the front panel of the ESG.

13. ESG_MarkerLength specifies the range of points over which the markers must
be set starting from the first point of the waveform. Depending on the setting of
ESG_EventMarkerType, the length of trigger Event1 or Event2 (or both) is set
to a multiple of the pulsewidth that, in turn, is determined by the sample clock
rate of the DAC output.

Simulation Measurement Displays
After running the test bench simulation and opening the Data Display pages, the
simulation results will be displayed for each measurement selected.

Note Measurement results from a wireless test bench have associated names that can
be used in Data Display Expressions. For more information, refer to Appendix B,
Measurement Results for Expressions.

RF Envelope Measurement

The RF envelope measurement (not defined in IEEE 802.11b) is used to show the
time envelope of each field in IEEE 802.11b RF signal burst, such as ramp, preamble
and header, and PSDU. Two signals are tested: the RF signal at the input of the
RF DUT and the Meas signal at the output of the RF DUT.
2-32 Simulation Measurement Displays



From the RF signal, the basic signal burst information (long preamble time, short
preamble time, data time) are listed in Table 2-4.

For the RF signal, the time envelope of one complete burst of 11b are shown, as well
as the time envelope of ramp, Preamble and Header, PSDU in Figure 2-6 through
Figure 2-9.

Figure 2-6 shows an entire 11b burst with a long preamble setting. The initial time
interval of 5.0 µsec is the idle time when the transmitter sends no signal. The second
time interval of 2.0 µsec is the ramp which simulates the transmitter switching
power-on or power-off. The third interval of 192 µsec is the Preamble and Header; if
short preamble setting is selected, this part is 96 µsec. The next interval of 160 octets
is where the PSDU is attached which carries the data payload.

Figure 2-6. RF Signal Time Envelope of One Complete Burst

Table 2-4. RF Signal Burst Information

Parameter Test Bench Default Value

RF_FSource 2412.0 MHz

RF_R 50.0 Ohm

Meas_FMeasurement 2412.0 MHz

Meas_R 50.0 Ohm

BurstTime 322.364 usec

IdleTime 10.0 usec

BitRate 11.0 Mbps

RF_Power_dBm 16.021 dBm

BytesPerBurst 160

DataTime 116.364 usec
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In Figure 2-7, you can see the ramp from 5.0 µsec to 7.0 µsec, indicating the
transmitter is power-on, and the ramp attached PSDU indicates the transmitter is
power-off.

Figure 2-7. RF Signal Time Envelope of Ramp Time

Figure 2-8 shows the time envelope of the Long Preamble and header. Long Preamble
and header lasts from 7.0 µsec to 199.0 µsec. The initial 144 µsec interval is the Long
Preamble. The next 48 µsec interval is the header. If Short Preamble is set, the Long
Preamble interval is 72 µsec, and the header interval is 24 µsec.

Figure 2-8. Time Envelope of Long Preamble and Header for RF Signal

In Figure 2-9, DATA is approximately 116 µsec and lasts from 199.0 µsec to 315.0
µsec.
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Figure 2-9. Time Envelope of DATA for RF Signal

In Meas signal testing, all measurements are similar to that for the RF signal, the
difference is that Meas signal contains any linear and nonlinear distortions and time
delay from RF DUT. All time envelope measurements for the Meas signal have the
RF DUT time delay. The envelope measurements for Meas signal are shown in
Figure 2-10 through Figure 2-13.

In Figure 2-10, Marker m1 must be set manually by the user to the start of the Short
Preamble; this is used to determine the RF DUT time delay. This RF DUT delay is
used to identify where each Meas burst structure begins and ends. The delay can be
calculated by subtracting half idle time from the time marked m1; for example, in
this figure, the delay=7.0µsec-5.0µsec=2.0µsec. If the marker does not point to the
accurate position, the calculated delay will not be accurate.

Figure 2-10. Time Envelope of One Entire Burst for Meas Signal
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In Figure 2-11, you can see the ramp from 7.0 to 9.0 µsec. Figure 2-12 shows the Long
Preamble and Header is 192.0 µsec and lasts 9.0 to 201.0 µsec. Figure 2-13 shows the
DATA is approximately 116.0 µsec and lasts 201.0 to 317.0 µsec.

Figure 2-11. Time Envelope of Short Preamble for Meas Signal

Figure 2-12. Meas Signal Long Preamble and Header Time Envelope

Figure 2-13. of Meas Signal Data Time Envelope
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Constellation Measurement

The constellation measurement (not defined in IEEE 802.11b) measures the
constellation of PSDU.

In IEEE 802.11b: 1, 2, 5.5, and 11 Mbps data rates for long preamble are supported in
PSDU; 2, 5.5, and 11 data rates for short preamble are supported. DBPSK, DQPSK,
CCK, or PBCC modulations correspond to each data rate; modulation types based on
data rates are given in Table 2-5.

The basic parameters for this measurement are given in Table 2-6.

For the 11Mbps data rate selected in this measurement, CCK modulation is used; the
constellations for RF and Meas signals are shown in Figure 2-14 and Figure 2-15.

Table 2-5. Data Rates and Modulation Types

Data Rate (Mbits/s) Modulation

1 DBPSK

2 DQPSK

5.5 CCK, PBCC

11 CCK, PBCC

Table 2-6. Basic Constellation Measurement Parameters

Parameter Default

RF_FSource 2412.0 MHz

RF_R 50.0 Ohm

DataTime 116.36 usec

BurstTime 322.364.0 usec

TimeStep 15.151515 nsec

BitRate 11.0 Mbps

Meas_FMeasurement 2412.0.0 MHz

Meas_R 50.0 Ohm
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Figure 2-14. RF Signal Constellation

Figure 2-15. Meas Signal Constellation
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Power Measurement

The power measurement (not defined in IEEE 802.11b) shows the CCDF
(complementary cumulative distribution function) transmission curves and
peak-to-average ratio for the RF and Meas signals.

The basic parameters for this measurement are listed in Table 2-7.

Measurement results are shown in Figure 2-16 and Figure 2-17.

Figure 2-16. RF Power CCDF

Table 2-7. Basic Power Measurement Parameters

Parameter Default

RF_FSource 2412.0MHz

RF_R 50.0Ohm

Meas_FMeasurement 2412.0MHz

Meas_R 50.0Ohm

RF_Power_dBm 16.021dBm

Gaussian
Noise
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Figure 2-17. Meas Power CCDF

In these figures, the blue curves are the reference CCDF for Gaussian noise. They can
be calculated by calling the function power_ccdf_ref() in the .dds files directly, as
shown in Figure 2-18.

Figure 2-18. Reference CCDF Calculation

Gaussian
Noise
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The function for calculating the peak-average-ratio for as well as the results are
shown in Figure 2-19 and Figure 2-20.

Figure 2-19. RF Signal Peak-Average-Ratio Calculation and Results

Figure 2-20. Meas Signal Peak-Average-Ratio Calculation and Results
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Spectrum Measurement

The Spectrum measurement is used to verify whether the transmitted spectrum
meets the spectrum mask according to IEEE Std 802.11b-1999, section 18.4.7.3
requirements. The transmitted spectrum must be less -30 dBr (dB relative to the
SINx/x peak) for

fc-22MHz<f<fc-11MHz

and

fc+11MHz<f<fc+22MHz;

and must be less than -50 dBr for

f<fc-22MHz

and

f>fc+22MHz

where fc is the channel center frequency.

The transmitted spectral density of the transmitted signal must fall within the
spectral mask illustrated in Figure 2-21; measurements must be made using a
100 kHz resolution bandwidth and a 100 kHz video bandwidth.

Figure 2-21. Transmit Spectrum Mask

Measurement results are shown in Figure 2-22 and Figure 2-23. From these figures,
you can see that the spectrums are within the spectrum mask; therefore, the
transmitted spectrum meets the specification requirement. Please note, the shapes of
spectrums are dependent on the shape of transmitter filter, filter length, and roll
factor. The spectrums of these figures are generated by a Gaussian filter with filter
length of 10 and roll factor of 0.5.
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Figure 2-22. RF Signal Spectrum

Figure 2-23. Meas Signal Spectrum
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EVM Measurement

The EVM measurement tests the transmit modulation accuracy (EVM) according to
IEEE Std 802.11b-1999, section 18.4.7.8. The transmit modulation accuracy
requirement for the high rate PHY is based on the difference between the actual and
the ideal signal waveform. Modulation accuracy is determined by measuring the peak
vector error magnitude during each chip period. Worst-case vector error magnitude
cannot exceed 0.35 for the normalized sampled chip data. The ideal complex I and Q
constellation points associated with DQPSK modulation, (0.707,0.707), (0.707,
–0.707), (–0.707, 0.707), (–0.707, –0.707), are used as the reference.

Measurements are from baseband I and Q sampled data after recovery through a
reference receiver system. Figure 2-24 illustrates the ideal DQPSK constellation
point and range of worst-case error specified for modulation accuracy.

This measurement provides averaged EVM rms specified by percent and the
transient EVM varied with burst.

Figure 2-24. Modulation Accuracy Measurement Example
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The basic parameters used for this measurement are given in Table 2-8.

Averaged results are shown in Figure 2-25 and Figure 2-26.

Figure 2-25. RF Signal Averaged EVM

Figure 2-26. Meas Signal Averaged EVM

Table 2-8. Basic EVM Measurement Parameters

Parameter Default Value

RF_FSource 2412.0 MHz

RF_R 50.0 Ohm

Meas_FMeasurement 2412.0 MHz

Meas_R 50.0 Ohm

RF_Power_dBm 16.021 dBm

BytesPerBurst 160

BitRate 11 Mbps

BurstTime 322.364 usec

DataTime 116.364 nsec
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The variation of EVM rms and peak EVM with bursts are shown in Figure 2-27 and
Figure 2-28. The RF EVM or Meas EVM do not exceed the 35% value required by
specification and therefore meet specification requirements.

Figure 2-27. RF Signal Variation of EVM rms and Peak EVM with Bursts
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Figure 2-28. Meas Signal Variation of EVM rms and Peak EVM with Bursts
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Test Bench Variables for Data Displays

The following tables identify the reference variables used to set up this test bench:

Table 2-9. Test Bench Constants for WLAN 11b Signal Setup

Constant  Value

BitsPerByte 8

RampTime if(PwrRamp==0) then 0.0 else 2*2.0usec endif

LongPreambleTime 192.0usec

ShortPreambleTime 96.0usec

PLCPTime if(PreambleFormat==0) then LongPreambleTime else ShortPreambleTime endif

PSDUTime DataLength*BitsPerByte/BitRate

Dependent on DataRate in Table 2-10
BandWidth 11.0MHz

Table 2-10. DataRate Determines BitRate Value

DataRate

BitRate
(Table 2-11)

Mbps_1 1e6

Mbps_2 2e6

Mbps_5.5 5.5e6

Mbps_11 11e6

Table 2-11. Test Bench Equations Derived from
Test Bench Parameters and

Exported to the Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

RF_SourceTemp SourceTemp

TimeStep 1/(Bandwidth*OversamplingRatio)
This is the test bench simulation time step.

IdleTime IdleInterval
This is the duration of the zero level idle field at the front of each burst.

DataTime PSDUTime
This is the duration of the PSDU field after the PLCP field in each burst.
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Baseline Performance
• Test Computer Configuration

• Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3

• Conditions

• Measurements made with default test bench settings.

• RF DUT is an RF system behavior component.

• The number of time points in one WLAN 802.11b burst is a function of
OversamplingRatio, PwrRamp, PreambleFormat, IdleInterval, DataRate,
DataLength.

OversamplingRatio = 6
PwrRamp = Linear
PreambleFormat = Long
IdleInterval = 10.0 µsec
DataRate = 11 Mb/s
DataLength = 160

• Resultant WTB_TimeStep = 15.152 nsec; BurstTime = 322.364 µsec; time
points per burst = 21276

• Simulation times and memory requirements:

BurstTime RampTime+PLCPTime+PSDUTime+IdleTime

SamplesPerBurst BurstTime/TimeStep
This is the number of Samples in aburst.

BytesPerBurst DataLength
This is the number of bytes of data in the Data field in each burst.

BitRate Dependant on DataRate in Table 2-10
This is the bit rate for transmitted WLAN signal.

Meas_FMeasurement FMeasurement

Meas_R MeasR

Table 2-11. Test Bench Equations Derived from
Test Bench Parameters and

Exported to the Data Display (continued)

Data Display Parameter Equation with Test Bench Parameters
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Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench
and the RF DUT Circuit Envelope simulation with the same signal and number of
time points. For example, if the RF DUT performance with Circuit Envelope
simulation alone takes 2 hours and consumes 200 MB of memory (excluding the
memory consumed by the core ADS product), then add these numbers to the Baseline
Performance numbers to determine the expected ADS performance. This is valid only
if the full memory consumed is from RAM. If RAM is less, larger simulation times
may result due to increased disk access time for swap memory usage.
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Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.

WLAN_802_11b_TX
Measurement

Bursts
Measured

Simulation
Time (sec)

ADS Processes
(MB)

RF_Envelope 3 23 110

Constellation 3 9 72

Power 3 6 60

Spectrum 3 7 57

EVM 10 23 63
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Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation to learn how to improve simulation speed.

WLAN Links

European Radiocommunications Office: http://www.ero.dk

U.S. Frequency Allocations Chart: http://www.ntia.doc.gov/osmhome

IEEE 802.11b Compliance Organization: http://www.wi-fi.org

HomeRF Resource Center: http://www.homerf.org

IEEE 802.11 Working Group: http://grouper.ieee.org/groups/802/11/index.html
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Chapter 3: WLAN 802.11a Receiver
Sensitivity Test

Introduction
WLAN_802_11a_RX_Sensitivity is the test bench for WLAN receiver minimum and
maximum input level sensitivity testing. The test bench enables users to connect to
an RF DUT and determine its performance; signal measurements include BER and
PER with minimum and maximum input levels.

The signal and the measurement are designed according to IEEE Standard
802.11a-1999.

This WLAN signal source model is compatible with the Agilent Signal Studio
Software option 417. Details regarding Signal Studio for WLAN 802.11 are included
at the website http://www.agilent.com/find/signalstudio.

This test bench includes a TX DSP section, an RF modulator, RF output source
resistance, an RF DUT connection, RF receivers, and DSP measurement blocks as
illustrated in Figure 3-1. The generated test signal is sent to the DUT.

Figure 3-1. Receiver Wireless Test Bench Block Diagram

The 802.11a/g signal burst is illustrated in Figure 3-2 and Figure 3-3. Each burst is
separated by IdleInterval and consists of Short Preamble, Long Preamble, SIGNAL,
and DATA fields.

• Short Preamble field consists of 10 short preambles (8 µsec).

• Long Preamble field consists of 2 long preambles (8 µsec). The two preamble
fields combined compose the PLCP Preamble that has a constant duration (16
µsec) for all source parameter settings.

• SIGNAL field includes 802.11a/g bursts of information (data rate, payload data,
and length).

• DATA field contains payload data.
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RF Output
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Channel coding, interleaving, mapping, and IFFT processes are also included in
SIGNAL and DATA parts generation. The SIGNAL field and each individual Data
field (part of the overall DATA field) have a duration defined as OFDM_SymbolTime
and includes a GuardInterval. OFDM _SymbolTime depends on Bandwidth
(=64/Bandwidth).

In Figure 3-2 and Figure 3-3, PLCP means physical layer convergence procedure,
PSDU means PLCP service data units, GI means guard interval; GI is set to 0.25 and
Bandwidth is set to 20 MHz (resulting in OFDM_SymbolTime = 4 µsec).

Figure 3-2. 802.11a/g Burst Format

Figure 3-3. OFDM Training Structure

The WLAN RF power delivered into a matched load is the average power delivered in
the WLAN burst excluding the burst idle time. Figure 3-4 shows the RF envelope for
an output RF signal with 10 dBm power.
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Figure 3-4. WLAN 802.11a RF Signal Envelope

Test Bench Basics
A template is provided for this test bench.

Figure 3-5. WLAN 802.11a Receiver Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose
WLAN_802_11a_RX_Sensitivity_test, click OK; click left to place the template
in the schematic window.

An example design using this template is available; from the ADS Main window click
File > Example Project > WLAN > WLAN_RF_Verification_prj >
WLAN_802_11a_RX_Sensitivity_test.dsn.

The basics for using the test bench are:
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• Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

• CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your requirements.

• Activate/deactivate measurements based on your requirements.

• Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to “Test Bench Details” on page 3-4.

Test Bench Details
The following sections provide details for setting up a test bench, setting
measurement parameters for more control of the test bench, simulation
measurement displays, and baseline performance.

Open and use the WLAN_802_11a_RX_Sensitivity template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose
WLAN_802_11a_RX_Sensitivity_test, click OK; click left to place the template
in the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

For information regarding using certain types of DUTs, see Appendix A, RF
DUT Limitations.

2. Set the Required Parameters

Note Refer to “WLAN_802_11a_RX_Sensitivity” on page 3-7 for a complete list
of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by
the user as needed.

• Set CE_TimeStep.
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Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with
time-step coordination occurring in the interface between the technologies.

CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=12.5 nsec.
The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/(Bandwidth × Ratio)

where

Bandwidth is the user-settable value (default = 20 MHz)

Ratio is the oversampling ratio value specified by OversamplingOption (not
the enum index). Ratio sets the number of waveform sampling points during
the signal FFT time interval. During this time interval the minimum FFT
sampling size is 64 (which corresponds to an FFT order of 6; i.e 26) and the
FFT time interval is defined as 64/Bandwidth. For example, a Ratio of 4 sets
the FFT sampling size to 64 × 4=256 (which corresponds to an FFT order of 8)
during the signal FFT time interval.

• Set FSource, SourcePower, and FMeasurement.

• FSource defines the RF frequency for the signal input to the RF DUT.

• SourcePower defines the power level for FSource. SourcePower is defined as
the average power during the non-idle time of the signal burst.

• FMeasurement defines the RF frequency output from the DUT to be
measured.

3. More control of the test bench can be achieved by setting Basic Parameters,
Signal Parameters, and measurement parameters. For details, refer to “Setting
Parameters” on page 3-10.

4. The RF modulator (shown in the block diagram in Figure 3-1) uses FSource,
SourcePower (Required Parameters), MirrorSourceSpectrum (Basic
Parameters), GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset,
and IQ_Rotation (Signal Parameters).
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The RF output resistance uses SourceR and SourceTemp (Basic Parameters).
The RF output signal source has a 50-ohm (default) output resistance defined
by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource),
with the specified source resistance (SourceR) and with power (SourcePower)
delivered into a matched load of resistance SourceR. The RF signal has additive
Gaussian noise power set by resistor temperature (SourceTemp).

Note that the Meas_in point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) (Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Figure 3-1) uses other Signal
Parameters.

5. More control of Circuit Envelope analysis can be achieved by setting Envelope
controller parameters. These settings include Enable AVM (Fast Cosim), which
may speed the RF DUT simulation more than 10×. Setting these simulation
options is described in Setting Automatic Verification Modeling Parameters and
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench
Simulation documentation.

6. To run a simulation, choose Simulate > Simulate in the Schematic window.

For details on Running a Simulation refer to the Wireless Test Bench
Simulation documentation.

7. Simulation results will appear in a Data Display window for each
measurement. “Simulation Measurement Displays” on page 3-14 describes
results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation
documentation.
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This section provides parameter information for Required Parameters, Basic
Parameters, Signal Parameters, and parameters for the various measurements.

Parameters

Name Description Default Sym Unit Type Range

RequiredParameters

CE_TimeStep Circuit envelope simulation
time step

1/20 MHz/4 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep<
=1/Bandwidth/2^Oversamp
lingOption.
  Expression variables are
in Signal Parameters
tab/category.

FSource Source carrier frequency:
CH1_2412.0MHz,
CH3_2422.0MHz,
CH5_2432.0MHz,
CH6_2437.0MHz,
CH7_2442.0MHz,
CH9_2452.0MHz,
CH11_2462.0MHz,
CH13_2472.0MHz,
CH36_5180.0MHz,
CH40_5200.0MHz,
CH44_5220.0MHz,
CH48_5240.0MHz,
CH52_5260.0MHz,
CH56_5280.0MHz,
CH60_5300.0MHz,
CH64_5320.0MHz,
CH149_5745.0MHz,
CH153_5765.0MHz,
CH157_5785.0MHz,
CH161_5805.0MHz

CH1_2412.0MHz Hz real enum (0, ∞)

SourcePower Source power dbmtow(-65.0) W real [0, ∞)
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FMeasurement Measurement carrier
frequency:
Meas_CH1_2412.0MHz,
Meas_CH3_2422.0MHz,
Meas_CH5_2432.0MHz,
Meas_CH6_2437.0MHz,
Meas_CH7_2442.0MHz,
Meas_CH9_2452.0MHz,
Meas_CH11_2462.0MHz,
Meas_CH13_2472.0MHz,
Meas_CH36_5180.0MHz,
Meas_CH40_5200.0MHz,
Meas_CH44_5220.0MHz,
Meas_CH48_5240.0MHz,
Meas_CH52_5260.0MHz,
Meas_CH56_5280.0MHz,
Meas_CH60_5300.0MHz,
Meas_CH64_5320.0MHz,
Meas_CH149_5745.0MHz
,
Meas_CH153_5765.0MHz
,
Meas_CH157_5785.0MHz
,
Meas_CH161_5805.0MHz

Meas_CH1_2412
.0MHz

Hz real enum (0, ∞)

BasicParameters

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor
temperature

16.85 Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO enum

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO enum

TestBenchSeed Random number generator
seed

1234567 int [0, ∞)

SignalParameters

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0 real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0 real (-∞, ∞)

IQ_Rotation IQ rotation 0.0 deg real (-∞, ∞)

Bandwidth Bandwidth 20 MHz  B Hz real (0, ∞)

Name Description Default Sym Unit Type Range
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Pin Inputs

Pin Outputs

OversamplingOption Oversampling ratio option:
Option 0 for Ratio 1, Option
1 for Ratio 2, Option 2 for
Ratio 4, Option 3 for Ratio
8, Option 4 for Ratio 16,
Option 5 for Ratio 32

Option 2 for Ratio
4

 S enum

DataRate Data rate (Mbps): Mbps_6,
Mbps_9, Mbps_12,
Mbps_18, Mbps_24,
Mbps_27, Mbps_36,
Mbps_48, Mbps_54

Mbps_54  R enum

IdleInterval Burst idle interval 4.0 usec  I sec real [0, 1000usec]

DataType Payload data type: PN9,
PN15, FIX4, _4_1_4_0,
_8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9 enum

DataLength Data length (bytes per
burst)

1000  L int [1, 4095]

GuardInterval Guard interval (frac FFT
size)

0.25 real [0, 1]

MeasurementParameters

DisplayPages RX sensitivity display
pages:

WLAN_802_11a_RX_Sen
sitivity Table

DecoderType Decoder type: Hard, Soft,
CSI

CSI enum

TrunLen Path memory truncation
length

60 int [20, 200)

StartBurst Start burst 0 int [0, 1000]

StopBurst Stop burst 100 int [0, 1000]

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

Pin Name Description

1 RF_Out Test bench RF output to RF circuit

Name Description Default Sym Unit Type Range
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Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note For required parameter information, see “Set the Required Parameters” on
page 3-4.

Basic Parameters

1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k
is Boltzmann’s constant.

3. MeasR defines the load resistance for the RF DUT output Meas signal into the
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for Meas signal power measurements.

4. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the
generated RF signal before it is sent to the RF DUT. Depending on the
configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set
this parameter to YES.

5. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the
Meas_in RF signal input to the test bench (and output from the RF DUT).
Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the
signal source (before any mirroring is done because of the
MirrorSourceSpectrum setting). Proper demodulation and measurement of the
RF DUT output signal requires that its RF envelope is not mirrored compared
to the signal generated by the signal source (before any mirroring is done
because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is
required for measurements on the Meas_in signal in RX text benches and
results in measurement on a signal with no spectrum mirroring.
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6. TestBenchSeed is an integer used to seed the random number generator used
with the test bench. This value is used by all test bench random number
generators, except those RF DUT components that use their own specific seed
parameter. TestBenchSeed initializes the random number generation. The
same seed value produces the same random results, thereby giving you
predictable simulation results. To generate repeatable random output from
simulation to simulation, use any positive seed value. If you want the output to
be truly random, enter the seed value of 0.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and
IQ_Rotation are used to add certain impairments to the ideal output RF signal.
Impairments are added in the order described here.

The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI(t) is the in-phase RF envelope, VQ(t) is the
quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.

Next, the signal VRF(t) is rotated by IQ_Rotation degrees. The I_OriginOffset
and Q_OriginOffset are then applied to the rotated signal. Note that the
amounts specified are percentages with respect to the output rms voltage. The
output rms voltage is given by sqrt(2 × SourceR × SourcePower).

2. Bandwidth is used to determine the actual bandwidth of WLAN systems and to
calculate the sampling rate and timestep per sample. The default value is 20
MHz (defined in 802.11a/g specification); to double the rate for the 802.11a/g
turbo mode, set Bandwidth to 40 MHz.

V RF t( ) A V I t( ) ωct( )cos gVQ t( ) ωct
φπ
180
---------+ 

 sin– 
 =

g 10

GainImbalance
20

-----------------------------------------------

=
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3. OversamplingOption sets the oversampling ratio of 802.11a/g RF signal source.
Options from 0 to 5 result in oversampling ratio 2, 4, 8, 16, 32 where
oversampling ratio = 2OversamplingOption. If OversamplingOption = 2, the
oversampling ratio = 22 = 4 and the simulation RF bandwidth is larger than the
signal bandwidth by a factor of 4 (e.g. for Bandwidth=20 MHz, the simulation
RF bandwidth = 20 MHz × 4 = 80 MHz).

4. DataRate specifies the data rate 6, 9, 12, 18, 24, 27, 36, 48 and 54 Mbps. All
data rates except 27 Mbps are defined in the 802.11a/g specification; 27 Mbps is
from HIPERLAN/2.

Table 3-1 lists key parameter values of 802.11a/g.

5. IdleInterval specifies the idle interval between two consecutive bursts when
generating a 802.11a signal source.

6. For DataType:

• if PN9 is selected, a 511-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.153.

• if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.

• if FIX4 is selected, a zero-stream is generated.

Table 3-1. Rate-Dependent Values

Data Rate
(Mbps) Modulation Coding Rate (R)

Coded Bits per
Subcarrier
( )

Coded Bits per
OFDM Symbol
( )

Data Bits per
OFDM Symbol
( )

6 BPSK 1/2 1 48 24

9 BPSK 3/4 1 48 36

12 QPSK 1/2 2 96 48

18 QPSK 3/4 2 96 72

24 16-QAM 1/2 4 192 96

27 16-QAM 9/16 4 192 108

36 16-QAM 3/4 4 192 144

48 64-QAM 2/3 6 288 192

54 64-QAM 3/4 6 288 216

NBPSC NCBPS NDBPS
3-12 Setting Parameters



• if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s
and the second x bits are 0s.

7. DataLength is used to set the number of data bytes in a burst. There are 8 bits
per byte.

8. GuardInterval is used to set cyclic prefix in an OFDM symbol. The value range
of GuardInterval is [0.0,1.0]. The cyclic prefix is a fractional ratio of the IFFT
length. 802.11a/g defines GuardInterval=1/4 (0.8 µsec) and HIPERLAN/2
defines two GuardIntervals (1/8 and 1/4).

Measurement Parameters

Measurement requires setting the MirrorMeasSpectrum parameter such that there
is an even number of spectrum mirrorings from the combined test bench source and
RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its
output RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.

1. DisplayPages provides Data Display page information for this measurement. It
cannot be changed by the user.

2. DecoderType has three modes: Hard, Soft, and CSI. When DecoderType=Hard,
if b < 0, -1.0 is output, otherwise 1.0 is output; when DecoderType=Soft, if b <
-1.0, -1.0 is output; if b > 1.0, 1.0 is output; when DecoderType=CSI, b is
multiplied by CSI (= |H(i)|2) and output. CSI means Channel Status
Information and estimated channel impulse responses (H(i)) are the CSI here.

3. TrunLen sets the most recent TrunLen information bits in each surviving
sequence are stored. Once the path with the shortest distance is identified, the
symbol associated with the path TrunLen periods ago is conveyed to the output
as a decoded information symbol.

4. StartBurst sets the start burst. A value of 0 is the first burst.

5. StopBurst sets the stop burst. A StopBurst value of 100 results in measuring
101 bursts.
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Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for
each measurement activated.

Note Measurement results from a wireless test bench have associated names that can
be used in Data Display Expressions. For more information, refer to Appendix B,
Measurement Results for Expressions.

Sensitivity Measurement

The sensitivity measurement shows BER and PER results.

Table 3-2 defines receiver minimum sensitivity measured at the receiver antenna
connector for each data rate in the 802.11a specification. SourcePower can be set at
the value in the table to perform receive minimum sensitivity tests. According to
specification [1] 17.3.10.1, the packet error rate (PER) shall be less than 10% at a
DataLength (PSDU length) of 1000 bytes at rate-dependent input levels listed in
Table 3-2 or less. If the SourcePower is less than the value in Table 3-2 when PER is
less than 10%, the sensitivity measurement is passed.

Simulation results for data rate of 54 Mbps and SourcePower of -65 dBm are
displayed in Figure 3-6.

The receiver maximum input level sensitivity is defined in section 17.3.10.4, IEEE
Std 802.11a-1999. The PER must be less than 10% at a DataLength (PSDU length) of

Table 3-2. Minimum Sensitivity Performance Requirement

Data Rate (Mbps) Minimum sensitivity (dBm)

6 -82

9 -81

12 -79

18 -77

24 -74

36 -70

48 -66

54 -65
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1000 bytes for a maximum input level of -30 dBm measured at the receiver antenna
connector for any baseband modulation.

Figure 3-6. Simulation Results for 54 Mbps Data Rate and -65 dBm SourcePower

Parameters in the Data Display are described in Table 3-5. EbN0_RF_dB is the local
Eb/N0 measured at the input of the RF DUT and calculated by the following
equations:

T = real(RF_SourceTemp) + 273.15
k = Boltzmann’s constant
N0_dBm = 10*log10(k * T) + 30
EbN0_RF_dB = real(RF_Power_dBm) - N0_dBm - 10*log10(real(BitRate))

Local Eb/No and system Eb/No are described in Receiver Eb/No Definitions in
Wireless Test Bench Simulation documentation.
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Test Bench Variables for Data Displays

The following tables identify the reference variables used to set up this test bench:

Table 3-3. Test Bench Constants for WLAN Signal Setup

Constant  Value

MinFFT_Size 64 (= 2^6)

BitsPerByte 8

ServiceBits 16

TailBits 6

Ratio Oversampling ratio related to the OversamplingOption as Ratio =
2^OversamplingOption

DataBitsPerOFDMSymbol Dependent on DataRate in Table 3-4.

OFDMSymbolsPerBurst (int ((ServiceBits+BitsPerByte*DataLength+TailBits)/
DataBitsPerOFDMSymbol))+Tail

TailCondition ServiceBits+BitsPerByte*DataLength+TailBits - DataBitsPerOFDMSymbol *(int
((ServiceBits+BitsPerByte*DataLength+TailBits)/ DataBitsPerOFDMSymbol))

Tail if (TailCondition = 0) then 0 else 1

Table 3-4. DataRate Determines
DataBitsPerOFDMSymbol and BitRate Values

DataRate

DataBitsPerOFDMSymbol
(Table 3-3)

BitRate
(Table 3-5)

Mbps_6 24 6e6

Mbps_9 36 9e6

Mbps_12 48 12e6

Mbps_18 72 18e6

Mbps_24 96 24e6

Mbps_27 108 27e6

Mbps_36 144 36e6

Mbps_48 192 48e6

Mbps_54 216 54e6
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Baseline Performance
• Test Computer Configuration

• Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3

• Conditions

Table 3-5. Test Bench Equations Derived from
Test Bench Parameters and
Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

RF_SourceTemp SourceTemp in degrees Celcius

TimeStep 1/(Bandwidth*Ratio)
This is the test bench simulation time step.

OFDM_SymbolTime MinFFT_Size*(1+GuardInterval)/Bandwidth
This is the duration for one PFDM symbol.

OFDM_SymbolsPerBurst OFDMSymbolsPerBurst
This is the number of OFDM symbols in the Data field of a burst.

OFDM_SymbolGuardInterval GuardInterval
This is the guard interval (as a ratio of the OFDM_SymbolTime) associated with each
OFDM symbol.

IdleTime IdleInterval
This is the duration of the zero level idle field at the front of each burst.

ShortPreambleTime 8.0 usec
This is the duration of the short preamble field after the idle field in each burst.

LongPreambleTime 8.0 usec
This is the duration of the long preamble field after the short preamble field in each burst.

SIGNAL_Time OFDM_SymbolTime
This is the duration of the SIGNAL field after the long preamble field in each burst.

DataTime OFDM_SymbolsPerBurst*OFDM_SymbolTime
This is the duration of the Data field after the SIGNAL field in each burst.

BurstTime IdleTime + ShortPreambleTime + LongPreambleTime + SIGNAL_Time + DataTime

BytesPerBurst DataLength
This is the number of bytes of data in the Data field in each burst.

BitRate Dependent on DataRate in Table 3-4
This is the bit rate for transmitted WLAN signal.

Meas_FMeasurement FMeasurement

Meas_R MeasR
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• Measurements made with default test bench settings.

• RF DUT is an RF system behavior component.

• Number of time points in one WLAN 802.11a burst is a function of
Bandwidth, OversamplingOption, IdleInterval, GuardInterval, DataRate,
DataLength

Bandwidth = 20 MHz
OversamplingOption = Option 2 for Ratio 4
IdleInterval = 4 µsec
GuardInterval = 0.25
DataRate = 54 Mbps
DataLength = 1000

• Resultant WTB_TimeStep = 12.5 nsec; BurstTime = 176 µsec; time points per
burst = 14080

• Simulation time and memory requirements:

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench
and the RF DUT Circuit Envelope simulation with the same signal and number of
time points. For example, if the RF DUT performance with Circuit Envelope
simulation alone takes 2 hours and consumes 200 MB of memory (excluding the
memory consumed by the core ADS product), then add these numbers to the Baseline
Performance numbers to determine the expected ADS performance. This is valid only
if the full memory consumed is from RAM. If RAM is less, larger simulation times
may result due to increased disk access time for swap memory usage.

WLAN_802_11a_RX_Sensitivity
Measurement

Bursts
Measured

Simulation Time
(sec)

ADS Processes
(MB)

RX Sensitivity 100 52 56
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Chapter 4: WLAN 802.11b Receiver
Sensitivity Test

Introduction
WLAN_802_11b_RX_Sensitivity is the test bench for WLAN receiver minimum and
maximum input level sensitivity testing. The test bench enables users to connect to
an RF DUT and determine its performance.

The signal and the measurements are designed according to the IEEE Standard
802.11b-1999 specification.

This WLAN signal source model is compatible with the Agilent Signal Studio
Software option 417. Details regarding Signal Studio for WLAN 802.11 are included
at the website http://www.agilent.com/find/signalstudio.

This test bench includes a TX DSP section, an RF modulator, RF output source
resistance, an RF DUT connection, RF receivers, and DSP measurement blocks as
illustrated in Figure 4-1. The generated test signal is sent to the DUT.

Figure 4-1. Receiver Wireless Test Bench Block Diagram

The 802.11b baseband signal source frame structure is illustrated in Figure 4-2 and
Figure 4-3. Each frame is separated by an IdleInterval; one 802.11b frame consists of
PLCP Preamble, PLCP Header and Data (PSDU) parts. (PPDU means physical layer
protocol data units; SFD means start frame delimiter; CRC means cyclic redundancy
code; PLCP means physical layer convergence procedure; PSDU means PLCP service
data units.)
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Figure 4-2. Long PLCP Frame Format

Figure 4-3. Short PLCP Frame Format

The WLAN 11b RF power delivered into a matched load is the average power
delivered in the WLAN burst excluding the burst idle time. Figure 4-4 shows the RF
envelope for an output RF signal with 16 dBm power and a 10 µsec idle time.
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Figure 4-4. WLAN 802.11b RF Signal Envelope

Test Bench Basics
A template is provided for this test bench.

Figure 4-5. WLAN 802.11b Receiver Sensitivity Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose
WLAN_802_11b_RX_Sensitivity_test, click OK; click left to place the template
in the schematic window.

An example design using this template is available; from the ADS Main window click
File > Example Project > WLAN > WLAN_RF_Verification_prj >
WLAN_802_11b_RX_Sensitivity_test.dsn.

The basics for using the test bench are:
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• Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

• CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your requirements.

• Activate/deactivate measurements based on your requirements.

• Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to “Test Bench Details” on page 4-4.

Test Bench Details
The following sections provide details for setting up a test bench, setting
measurement parameters for more control of the test bench, simulation
measurement displays, and baseline performance.

Open and use the WLAN_802_11b_RX_Sensitivity template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose
WLAN_802_11b_RX_Sensitivity_test, click OK; click left to place the template
in the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

For information regarding using certain types of DUTs, see Appendix A, RF
DUT Limitations.

2. Set the Required Parameters

Note Refer to “WLAN_802_11b_RX_Sensitivity” on page 4-7 for a complete list
of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by
the user as needed.

• Set CE_TimeStep.
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Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with
time-step coordination occurring in the interface between the technologies.

CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings
WTB_TimeStep=1/(11.0e6 × 4) sec. The value is displayed in the Data Display
pages as TimeStep.

WTB_TimeStep = 1/(11.0e6 × Ratio)

where

11.0e6 means the baseband bandwidth of 11b is 11.0MHz.
Ratio is the OversamplingRatio value specified. OversamplingRatio sets the
number of waveform sampling points during one chip time interval.

• Set FSource, SourcePower, and FMeasurement.

• FSource defines the RF frequency for the signal input to the RF DUT.

• SourcePower defines the power level for FSource. SourcePower is defined as
the average power during the non-idle time of the signal burst.

• FMeasurement defines the RF frequency output from the DUT to be
measured.

3. More control of the test bench can be achieved by setting Basic Parameters,
Signal Parameters, and measurement parameters. For details, refer to “Setting
Parameters” on page 4-9.

4. The RF modulator (shown in the block diagram in Figure 4-1) uses FSource,
SourcePower (Required Parameters), MirrorSourceSpectrum (Basic
Parameters), GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset,
and IQ_Rotation (Signal Parameters).

The RF output resistance uses SourceR and SourceTemp (Basic Parameters).
The RF output signal source has a 50-ohm (default) output resistance defined
by SourceR.
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RF output (and input to the RF DUT) is at the frequency specified (FSource),
with the specified source resistance (SourceR) and with power (SourcePower)
delivered into a matched load of resistance SourceR. The RF signal has additive
Gaussian noise power set by resistor temperature (SourceTemp).

Note that the Meas_in point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) (Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Figure 4-1) uses other Signal
Parameters.

5. More control of Circuit Envelope analysis can be achieved by setting Envelope
controller parameters. These settings include Enable AVM (Fast Cosim), which
may speed the RF DUT simulation more than 10×. Setting these simulation
options is described in Setting Automatic Verification Modeling Parameters and
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench
Simulation documentation.

6. To run a simulation, choose Simulate > Simulate in the Schematic window.

For details on Running a Simulation refer to the Wireless Test Bench
Simulation documentation.

7. Simulation results will appear in a Data Display window for each
measurement. “Simulation Measurement Displays” on page 4-14 describes
results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation
documentation.
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This section provides parameter information for Required Parameters, Basic
Parameters, Signal Parameters, and parameters for the various measurements.

Parameters

Name Description Default Sym Unit Type Range

RequiredParameters

CE_TimeStep Circuit envelope simulation
time step

1/11 MHz/4 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/11e6/OversamplingRatio.
  OversamplingRatio is in
Signal Parameters tab.

FSource Source carrier frequency:
CH1_2412.0MHz,
CH3_2422.0MHz,
CH5_2432.0MHz,
CH6_2437.0MHz,
CH7_2442.0MHz,
CH9_2452.0MHz,
CH11_2462.0MHz,
CH13_2472.0MHz

CH1_2412.0MHz Hz real enum (0, ∞)

SourcePower Source power dbmtow(-76.0) W real [0, ∞)

FMeasurement Measurement carrier
frequency:
Meas_CH1_2412.0MHz,
Meas_CH3_2422.0MHz,
Meas_CH5_2432.0MHz,
Meas_CH6_2437.0MHz,
Meas_CH7_2442.0MHz,
Meas_CH9_2452.0MHz,
Meas_CH11_2462.0MHz,
Meas_CH13_2472.0MHz

Meas_CH1_2412
.0MHz

Hz real enum (0, ∞)

BasicParameters

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor
temperature

16.85 Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm Ohm real [10, 1.0e6]
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MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO enum

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO enum

TestBenchSeed Random number generator
seed

1234567 int [0, ∞)

SignalParameters

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0 real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0 real (-∞, ∞)

IQ_Rotation IQ rotation 0.0 deg real (-∞, ∞)

OversamplingRatio Oversampling ratio 4  S int [2, 9]

DataRate Data rate (Mbps):
Mbps_5.5, Mbps_11

Mbps_11  R enum

PreambleFormat Preamble format: Long,
Short

Long  H enum

CIkLockedFlag Lock header clock? NO,
YES

YES enum

PwrRamp RF power ramp shape:
None, Linear, Cosine

Linear  P enum

IdleInterval Burst idle interval 10.0 usec  I sec real [0, 1000us]

FilterType Shaping filter type:
NoneFilter, Gaussian, Root
Cosine, Ideal Lowpass

Root Cosine enum

RRC_Alpha RRC roll-off factor 0.22 real (0.0, 1.0]

GaussianFilter_bT Gaussian filter bT
coefficient

0.5 real (0.0, 1.0]

FilterLength Filter length (chips) 10 int [1, 200]

DataType Payload data type: PN9,
PN15, FIX4, _4_1_4_0,
_8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9 enum

DataLength Data length (bytes per
burst)

1024  L int [1, 2312]

MeasurementParameters

DisplayPages RX sensitivity
measurement display
pages:

WLAN_802_11b_RX_Sen
sitivity Table

Name Description Default Sym Unit Type Range
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Pin Inputs

Pin Outputs

Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note For required parameter information, see “Set the Required Parameters” on
page 4-4.

Basic Parameters

1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k
is Boltzmann’s constant.

ForwardTaps Number of equalizer
forward taps

6 int [1, 256]

FeedbackTaps Number of equalizer
feedback taps

3 int [1, 128]

EqualizerScaleFactor LMS algorithm scale factor 0.0006 real (0, 1.0)

StartBurst Start burst 0 int [0, 1000]

StopBurst Stop burst 125 int [0, 1000]

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

Pin Name Description

1 RF_Out Test bench RF output to RF circuit

Name Description Default Sym Unit Type Range
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3. MeasR defines the load resistance for the RF DUT output Meas signal into the
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for Meas signal power measurements.

4. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the
generated RF signal before it is sent to the RF DUT. Depending on the
configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set
this parameter to YES.

5. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the
Meas_in RF signal input to the test bench (and output from the RF DUT).
Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the
signal source (before any mirroring is done because of the
MirrorSourceSpectrum setting). Proper demodulation and measurement of the
RF DUT output signal requires that its RF envelope is not mirrored compared
to the signal generated by the signal source (before any mirroring is done
because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is
required for measurements on the Meas_in signal in RX text benches and
results in measurement on a signal with no spectrum mirroring.

6. TestBenchSeed is an integer used to seed the random number generator used
with the test bench. This value is used by all test bench random number
generators, except those RF DUT components that use their own specific seed
parameter. TestBenchSeed initializes the random number generation. The
same seed value produces the same random results, thereby giving you
predictable simulation results. To generate repeatable random output from
simulation to simulation, use any positive seed value. If you want the output to
be truly random, enter the seed value of 0.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and
IQ_Rotation are used to add certain impairments to the ideal output RF signal.
Impairments are added in the order described here.

The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:
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where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI(t) is the in-phase RF envelope, VQ(t) is the
quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.

Next, the signal VRF(t) is rotated by IQ_Rotation degrees. The I_OriginOffset
and Q_OriginOffset are then applied to the rotated signal. Note that the
amounts specified are percentages with respect to the output rms voltage. The
output rms voltage is given by sqrt(2 × SourceR × SourcePower).

2. OversamplingRatio sets the oversampling ratio of 802.11b RF signal source.
Eight oversampling ratios (2, 3, 4, 5, 6, 7, 8, 9) are supported. If
OversamplingRatio = 4, the simulation RF bandwidth is larger than the signal
bandwidth by a factor of 4 (e.g. for Bandwidth=11 MHz, the simulation RF
bandwidth = 11 MHz × 4 = 44 MHz).

3. DataRate specifies the data rate 1, 2, 5.5, or 11 Mbps (data rates are defined in
802.11b).

4. PreambleFormat is used to set the format of the framed signal preamble/header
sections; refer to Figure 4-2 and Figure 4-3.

5. ClkLockedFlag is used to toggle the clock locked flag in the header. This is Bit 2
in the Service field of the PPDU frame. This bit is used to indicate to the
receiver if the carrier and the symbol clock use the same local oscillator. If
ClkLockedFlag=YES, this bit is set to 1; if ClkLockedFlag=NO, this bit is set to
0.

6. PwrRamp is used to select the shape of the RF burst in framed mode; power
up/down ramp type is none, linear, or cosine.

• Cosine ramp gives least amount of out-of-channel interference.

• None starts transmitting the signal at full power, and is the simplest power
ramp to implement. The power up/down ramp is set to 2 µsec when PwrRamp
= none.

• Linear ramp shapes the burst in a linear fashion.

V RF t( ) A V I t( ) ωct( )cos gVQ t( ) ωct
φπ
180
---------+ 

 sin– 
 =
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=
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7. IdleInterval sets an idle duration time between two consecutive bursts when
generating the 802.11b signal source.

8. FilterType is used to specify that a baseband filter is applied to reduce the
transmitted bandwidth, thereby increasing spectral efficiency. The 802.11b
specification does not indicate the type of filter to be used, but the transmitted
signal must meet the spectral mask requirements. Four options for baseband
filtering are available:

• None (no filter)

• Gaussian The Gaussian filter does not have zero ISI. Wireless system
architects must determine how much of the ISI can be tolerated in a system
and combine that with noise and interference. The Gaussian filter is
Gaussian-shaped in time and frequency domains, and it does not ring as root
cosine filters do.

The effects of this filter in the time domain are relatively short and each
symbol interacts significantly (or causes ISI) with only the preceding and
succeeding symbols. This reduces the tendency for particular sequences of
symbols to interact which makes amplifiers easier to build and more efficient.

• Root Cosine (also referred to as square root raised-cosine) These filters have
the property that their impulse response rings at the symbol rate. Adjacent
symbols do not interfere with each other at the symbol times because the
response equals zero at all symbol times except the center (desired) one.

Root cosine filters heavily filter the signal without blurring the symbols
together at the symbol times. This is important for transmitting information
without errors caused by ISI. Note that ISI exists at all times except at
symbol (decision) times.

• Ideal Lowpass  In the frequency domain, this filter appears as a lowpass,
rectangular filter with very steep cut-off characteristics. The passband is set
to equal the symbol rate of the signal. Due to a finite number of coefficients,
the filter has a predefined length and is not truly ideal. The resulting ripple
in the cut-off band is effectively minimized with a Hamming window. A
symbol length of 32 or greater is recommended for this filter.

9. RRC_Alpha is used to set the sharpness of a root cosine filter when
FilterType=Root Cosine.
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10. GaussianFilter_bT is the Gaussian filter coefficient. B is the 3 dB bandwidth of
the filter; T is the duration of the symbol period. BT determines the extent of
the filtering of the signal. Common values for BT are 0.3 to 0.5.

11. FilterLength is used to set the number of symbol periods to be used in the
calculation of the symbol.

12. For DataType:

• if PN9 is selected, a 511-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.153

• if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151

• if FIX4 is selected, a zero-stream is generated

• if x_1_x_0 is selected, where x equals 4, 8, 16, 32, or 64, a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s
and the second x bits are 0s.

13. DataLength is used to set the number of data bytes in a frame.

14. The signal for this test bench uses the CCK modulation format.

Measurement Parameters

This measurement requires setting the MirrorMeasSpectrum parameter such that
there is an even number of spectrum mirrorings from the combined test bench source
and RF DUT. For example, if MirrorSourceSpectrum = NO and the RF DUT causes
its output RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum = YES.

1. DisplayPages is not user-editable. It provides information on the name of the
Data Display pages in which this measurement is contained.

2. ForwardTaps sets the number of forward taps for decision feedback equalizer
(DFE) in 802.11b receiver.

3. FeedbackTaps sets the number of feedback taps for DFE in 802.11b receiver.

4. EqualizerScaleFactor sets the scale factor of DFE, which determines the
convergence speed of DFE in 802.11b receiver.

5. StartBurst sets the start burst. A value of 0 is the first burst.
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6. StopBurst parameter sets the stop burst. A value of 125 results in measuring
126 bursts.

Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for
each measurement activated.

Note Measurement results from a wireless test bench have associated names that can
be used in Data Display Expressions. For more information, refer to Appendix B,
Measurement Results for Expressions.

Measurement

The sensitivity measurement shows BER and PER results.

The receiver minimum input level sensitivity is defined in section 18.4.8.1, IEEE Std
802.11b-1999. The PER must be less than 8% at a DataLength (PSDU) of 1024 bytes
(octets) for an input level of -76dBm measured at the receiver antenna connector.
This PER must be specified for 11Mbit/s CCK modulation.

Simulation results are shown in Figure 4-6.

Figure 4-6. Simulation Results for 11 Mbps Data Rate and -76 dBm SourcePower

Parameters used in the Data Display are described in Table 4-2. EbN0_RF_dB is the
local Eb/N0 measured at the input of the RF DUT and calculated by the following
equations:

T = real(RF_SourceTemp) + 273.15
k = Boltzmann’s constant
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N0_dBm = 10*log10(k * T) + 30
EbN0_RF = real(RF_Power_dBm) - N0_dBm - 10*log10(real(BitRate))

Local Eb/No and system Eb/No are described in Receiver Eb/No Definitions in
Wireless Test Bench Simulation documentation.
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Test Bench Variables for Data Displays

The following tables identify the reference variables used to set up this test bench:

Table 4-1. Test Bench Constants for WLAN Signal Setup

Constant  Value

BitsPerByte 8

RampTime if(PwrRamp==0) then 0.0 else 2*2.0 usec

LongPreambleTime 192.0 usec

ShortPreambleTime 96.0 usec

PLCPTime if(PreambleFormat==0) then LongPreambleTime else ShortPreambleTime

PSDUTime DataLength*BitsPerByte/BitRate

Dependent on DataRate in Table 4-2.

BandWidth 11.0e6

Table 4-2. DataRate Determines Value for BitRate

DataRate

BitRate
(Table 4-3)

Mbps_5.5 5.5e6

Mbps_11 11e6

Table 4-3. Test Bench Equations Derived from
Test Bench Parameters and
Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

RF_SourceTemp SourceTemp in degrees Celsius

TimeStep 1/(Bandwidth*OversamplingRatio)
This is the test bench simulation time step

IdleTime IdleInterval
This is the duration of the zero level idle field at the front of each burst

DataTime PSDUTime
This is the duration of the PSDU field after the PLCP field in each burst

BurstTime RampTime+PLCPTime+PSDUTime+IdleTime

SamplesPerBurst BurstTime/TimeStep
This is the number of Samples in aburst
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Baseline Performance
• Test Computer Configuration

• Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3

• Conditions

• Measurements made with default test bench settings.

• RF DUT is an RF system behavior component.

• Number of time points in one WLAN 802.11b burst is a function of
OversamplingRatio, PwrRamp, PreambleFormat, IdleInterval, DataRate,
DataLength

OversamplingRatio = 4
PwrRamp = Linear
PreambleFormat = Long
IdleInterval = 50.0 µsec
DataRate = 11 Mbps
DataLength = 1024

• Resultant WTB_TimeStep = 22.727 nsec; BurstTime = 990.727 µsec; time
points per burst = 43592

• Simulation time and memory requirements.

BytesPerBurst DataLength
This is the number of bytes of data in the Data field in each burst

BitRate Dependant on DataRate in Table 4-2
This is the bit rate for transmitted WLAN signal

Meas_FMeasurement FMeasurement

Meas_R MeasR

Measurement
Bursts
Measured

Simulation Time
(sec) ADS Processes (MB)

RX Sensitivity 125 170 74

Table 4-3. Test Bench Equations Derived from
Test Bench Parameters and

Exported to Data Display (continued)

Data Display Parameter Equation with Test Bench Parameters
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Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench
and the RF DUT Circuit Envelope simulation with the same signal and number of
time points. For example, if the RF DUT performance with Circuit Envelope
simulation alone takes 2 hours and consumes 200 MB of memory (excluding the
memory consumed by the core ADS product), then add these numbers to the Baseline
Performance numbers to determine the expected ADS performance. This is valid only
if the full memory consumed is from RAM. If RAM is less, larger simulation times
may result due to increased disk access time for swap memory usage.
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Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation to learn how to improve simulation speed.

WLAN Links

European Radiocommunications Office: http://www.ero.dk

U.S. Frequency Allocations Chart: http://www.ntia.doc.gov/osmhome
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Chapter 5: WLAN 802.11a Receiver Adjacent
Channel Rejection Test

Introduction
WLAN_802_11a_RX_ACR is the test bench for WLAN receiver adjacent and
non-adjacent channel rejection testing. The test bench enables users to connect to an
RF DUT and determine its performance.

The signal and the measurement are designed according to IEEE Standard
802.11a-1999.

This WLAN signal source model is compatible with the Agilent Signal Studio
Software option 417. Details regarding Signal Studio for WLAN 802.11 are included
at the website http://www.agilent.com/find/signalstudio.

This test bench includes a TX DSP section, an RF modulator, RF output source
resistance, an RF DUT connection, RF receivers, and DSP measurement blocks as
illustrated in Figure 5-1. The generated test signal is sent to the DUT.

Figure 5-1. Receiver Wireless Test Bench Block Diagram

The WLAN 802.11a/g signal burst is illustrated in Figure 5-2 and Figure 5-3. Each
burst, separated by IdleInterval, consists of Short Preamble, Long Preamble,
SIGNAL, and DATA fields.

• Short Preamble consists of 10 short preambles (8 µsec).

• Long Preamble consists of 2 long preambles (8 µsec). The two preamble fields
combined compose the PLCP Preamble that has a constant duration (16 µsec)
for all source parameter settings.

• SIGNAL includes 802.11a/g bursts of information (such as data rate, payload
data, and length).

• DATA contains payload data.
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Channel coding, interleaving, mapping and IFFT processes are also included in
SIGNAL and DATA parts generation. The SIGNAL field and each individual Data
field (part of the overall DATA field) have a time duration defined as
OFDM_SymbolTime and includes a GuardInterval. OFDM _SymbolTime depends on
Bandwidth (=64/Bandwidth).

In Figure 5-2 and Figure 5-3, PLCP means physical layer convergence procedure,
PSDU means PLCP service data units, GI means guard interval; GI is set to 0.25 and
Bandwidth is set to 20 MHz (resulting in OFDM_SymbolTime = 4 µsec).

Figure 5-2. 802.11a/g Burst Format

Figure 5-3. OFDM Training Structure

The WLAN RF power delivered into a matched load is the average power delivered in
the WLAN burst excluding the burst idle time. Figure 5-4 shows the RF envelope for
an output RF signal with 10 dBm power.
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Figure 5-4. WLAN 802.11a RF Signal Envelope

Test Bench Basics
A template is provided for this test bench.

Figure 5-5. WLAN 802.11a Receiver ACR Test Bench

To access the template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11a_RX_ACR_test, click
OK; click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click
File > Example Project > WLAN > WLAN_RF_Verification_prj >
WLAN_802_11a_RX__ACR_test.dsn.

The basics for using the test bench are:

• Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.
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• CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your requirements.

• Activate/deactivate measurements based on your requirements.

• Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to “Test Bench Details” on page 5-4.

Test Bench Details
The following sections provide details for setting up a test bench, setting
measurement parameters for more control of the test bench, simulation
measurement displays, and baseline performance.

Open and use the WLAN_802_11a_RX_ACR template:

1. In an Analog/RF schematic window select Insert > Template.

2. In the Insert > Template dialog box, choose WLAN_802_11a_RX_ACR_test, click
OK; click left to place the template in the schematic window.

Test bench setup is detailed here.

1. Replace the DUT (Amplifier2 is provided with this template) with an RF DUT
that is suitable for this test bench.

For information regarding using certain types of DUTs, see Appendix A, RF
DUT Limitations.

2. Set the Required Parameters

Note Refer to “WLAN_802_11a_RX_ACR” on page 5-7 for a complete list of
parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by
the user as needed.

• Set CE_TimeStep.

Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with
time-step coordination occurring in the interface between the technologies.
5-4 Test Bench Details



CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.

Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=6.25 nsec.
The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/(Bandwidth × Ratio)

where

Bandwidth is the user-settable value (default = 20 MHz)

Ratio is the oversampling ratio value specified by OversamplingOption (not
the enum index). Ratio sets the number of waveform sampling points during
the signal FFT time interval. During this time interval the minimum FFT
sampling size is 64 (which corresponds to an FFT order of 6; i.e 26) and the
FFT time interval is defined as 64/Bandwidth. For example, a Ratio of 4 sets
the FFT sampling size to 64 × 4=256 (which corresponds to an FFT order of 8)
during the signal FFT time interval.

• Set FSource, SourcePower, and FMeasurement.

• FSource defines the RF frequency for the signal input to the RF DUT. The
FSource value is exported to the Choosing Analyses window Fundamental
Tones field when the user clicks OK in the Wireless Test Bench Setup window.

• SourcePower defines the power level for FSource. SourcePower is defined as
the average power during the non-idle time of the signal burst.

• FMeasurement defines the RF frequency output from the DUT to be
measured.

3. More control of the test bench can be achieved by setting Basic Parameters,
Signal Parameters, and measurement parameters. For details, refer to “Setting
Parameters” on page 5-10.

4. The RF modulator (shown in the block diagram in Figure 5-1) uses FSource,
SourcePower (Required Parameters), MirrorSourceSpectrum (Basic
Parameters), GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset,
and IQ_Rotation (Signal Parameters).
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The RF output resistance uses SourceR and SourceTemp (Basic Parameters).
The RF output signal source has a 50-ohm (default) output resistance defined
by SourceR.

RF output (and input to the RF DUT) is at the frequency specified (FSource),
with the specified source resistance (SourceR) and with power (SourcePower)
delivered into a matched load of resistance SourceR. The RF signal has additive
Gaussian noise power set by resistor temperature (SourceTemp).

Note that the Meas_in point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) (Basic Parameters).

The Meas signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.

The TX DSP block (shown in the block diagram in Figure 5-1) uses other Signal
Parameters.

5. More control of Circuit Envelope analysis can be achieved by setting Envelope
controller parameters. These settings include Enable AVM (Fast Cosim), which
may speed the RF DUT simulation more than 10×. Setting these simulation
options is described in Setting Automatic Verification Modeling Parameters and
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench
Simulation documentation.

6. To run a simulation, choose Simulate > Simulate in the Schematic window.

For details on Running a Simulation refer to the Wireless Test Bench
Simulation documentation.

7. Simulation results will appear in a Data Display window for each
measurement. “Simulation Measurement Displays” on page 5-14 describes
results for each measurement available for this test bench.

For details on Viewing Results refer to the Wireless Test Bench Simulation
documentation.
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WLAN_802_11a_RX_ACR

This section provides parameter information for Required Parameters, Basic
Parameters, Signal Parameters, and parameters for the various measurements.

Parameters

Name Description Default Sym Unit Type Range

RequiredParameters

CE_TimeStep Circuit envelope simulation
time step

1/20 MHz/8 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep<
=1/Bandwidth/2^Oversamp
lingOption.
  Expression variables are
in Signal Parameters
tab/category.

FSource Source carrier frequency:
CH1_2412.0MHz,
CH3_2422.0MHz,
CH5_2432.0MHz,
CH6_2437.0MHz,
CH7_2442.0MHz,
CH9_2452.0MHz,
CH11_2462.0MHz,
CH13_2472.0MHz,
CH36_5180.0MHz,
CH40_5200.0MHz,
CH44_5220.0MHz,
CH48_5240.0MHz,
CH52_5260.0MHz,
CH56_5280.0MHz,
CH60_5300.0MHz,
CH64_5320.0MHz,
CH149_5745.0MHz,
CH153_5765.0MHz,
CH157_5785.0MHz,
CH161_5805.0MHz

CH1_2412.0MHz Hz real enum (0, ∞)

SourcePower Source power dbmtow(-62.0) W real [0, ∞)
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FMeasurement Measurement carrier
frequency:
Meas_CH1_2412.0MHz,
Meas_CH3_2422.0MHz,
Meas_CH5_2432.0MHz,
Meas_CH6_2437.0MHz,
Meas_CH7_2442.0MHz,
Meas_CH9_2452.0MHz,
Meas_CH11_2462.0MHz,
Meas_CH13_2472.0MHz,
Meas_CH36_5180.0MHz,
Meas_CH40_5200.0MHz,
Meas_CH44_5220.0MHz,
Meas_CH48_5240.0MHz,
Meas_CH52_5260.0MHz,
Meas_CH56_5280.0MHz,
Meas_CH60_5300.0MHz,
Meas_CH64_5320.0MHz,
Meas_CH149_5745.0MHz
,
Meas_CH153_5765.0MHz
,
Meas_CH157_5785.0MHz
,
Meas_CH161_5805.0MHz

Meas_CH1_2412
.0MHz

Hz real enum (0, ∞)

BasicParameters

SourceR Source resistance 50 Ohm Ohm real (0, ∞)

SourceTemp Source resistor
temperature

16.85 Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO enum

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO enum

TestBenchSeed Random number generator
seed

1234567 int [0, ∞)

SignalParameters

GainImbalance Gain imbalance, Q vs I 0.0 dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0 deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0 real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0 real (-∞, ∞)

IQ_Rotation IQ rotation 0.0 deg real (-∞, ∞)

Bandwidth Bandwidth 20 MHz  B Hz real (0, ∞)

Name Description Default Sym Unit Type Range
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Pin Inputs

OversamplingOption Oversampling ratio option:
Option 0 for Ratio 1, Option
1 for Ratio 2, Option 2 for
Ratio 4, Option 3 for Ratio
8, Option 4 for Ratio 16,
Option 5 for Ratio 32

Option 3 for Ratio
8

 S enum

DataRate Data rate (Mbps): Mbps_6,
Mbps_9, Mbps_12,
Mbps_18, Mbps_24,
Mbps_27, Mbps_36,
Mbps_48, Mbps_54

Mbps_54  R enum

IdleInterval Burst idle interval 4.0 usec  I sec real [0, 1000usec]

DataType Payload data type: PN9,
PN15, FIX4, _4_1_4_0,
_8_1_8_0, _16_1_16_0,
_32_1_32_0, _64_1_64_0

PN9 enum

DataLength Data length (bytes per
burst)

1000  L int [1, 4095]

GuardInterval Guard interval (frac FFT
size)

0.25 int [0, 1]

AdjChSignalParameters

AdjChFSourceOffset Adjacent channel carrier
frequency offset

-20 MHz Hz real (-∞, ∞)

AdjChPower Adjacent channel power dbmtow(-63.0) W real [0, ∞)

MeasurementParameters

DisplayPages RX adjacent channel
rejection measurement
display pages:

WLAN_802_11a_RX_ACR
Table

DecoderType Decoder type: Hard, Soft,
CSI

CSI enum

TrunLen Path memory truncation
length

60 int [20, 200)

StartBurst Start burst 0 int [0, 1000]

StopBurst Stop burst 100 int [0, 1000]

Pin Name Description

2 Meas_In Test bench measurement RF input from RF circuit

Name Description Default Sym Unit Type Range
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Pin Outputs

Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note For required parameter information, see “Set the Required Parameters” on
page 5-4.

Basic Parameters

1. SourceR is the RF output source resistance.

2. SourceTemp is the RF output source resistance temperature (oC) and sets noise
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k
is Boltzmann’s constant.

3. MeasR defines the load resistance for the RF DUT output Meas signal into the
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for Meas signal power measurements.

4. MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the
generated RF signal before it is sent to the RF DUT. Depending on the
configuration and number of mixers in an RF transmitter, the signal at the
input of the DUT may need to be mirrored. If such an RF signal is desired, set
this parameter to YES.

5. MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the
Meas_in RF signal input to the test bench (and output from the RF DUT).
Depending on the configuration and number of mixers in the RF DUT, the
signal at its output may be mirrored compared to the signal generated by the
signal source (before any mirroring is done because of the
MirrorSourceSpectrum setting). Proper demodulation and measurement of the
RF DUT output signal requires that its RF envelope is not mirrored compared

Pin Name Description

1 RF_Out Test bench RF output to RF circuit
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to the signal generated by the signal source (before any mirroring is done
because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is
required for measurements on the Meas_in signal in RX text benches and
results in measurement on a signal with no spectrum mirroring.

6. TestBenchSeed is an integer used to seed the random number generator used
with the test bench. This value is used by all test bench random number
generators, except those RF DUT components that use their own specific seed
parameter. TestBenchSeed initializes the random number generation. The
same seed value produces the same random results, thereby giving you
predictable simulation results. To generate repeatable random output from
simulation to simulation, use any positive seed value. If you want the output to
be truly random, enter the seed value of 0.

Signal Parameters

1. GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and
IQ_Rotation are used to add certain impairments to the ideal output RF signal.
Impairments are added in the order described here.

The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI(t) is the in-phase RF envelope, VQ(t) is the
quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.

Next, the signal VRF(t) is rotated by IQ_Rotation degrees. The I_OriginOffset
and Q_OriginOffset are then applied to the rotated signal. Note that the
amounts specified are percentages with respect to the output rms voltage. The
output rms voltage is given by sqrt(2 × SourceR × SourcePower).

V RF t( ) A V I t( ) ωct( )cos gVQ t( ) ωct
φπ
180
---------+ 

 sin– 
 =

g 10

GainImbalance
20

-----------------------------------------------

=
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2. Bandwidth is used to determine the actual bandwidth of WLAN systems and to
calculate the sampling rate and timestep per sample. The default value is 20
MHz (defined in 802.11a/g specification); to double the rate for the 802.11a/g
turbo mode, set Bandwidth to 40 MHz.

3. OversamplingOption sets the oversampling ratio of 802.11a/g RF signal source.
Options from 0 to 5 result in oversampling ratio 2, 4, 8, 16, 32 where
oversampling ratio = 2OversamplingOption. If OversamplingOption = 2, the
oversampling ratio = 22 = 4 and the simulation RF bandwidth is larger than the
signal bandwidth by a factor of 4 (e.g. for Bandwidth=20 MHz, the simulation
RF bandwidth = 20 MHz × 4 = 80 MHz).

4. DataRate specifies the data rate 6, 9, 12, 18, 24, 27, 36, 48 and 54 Mbps. All
data rates except 27 Mbps are defined in the 802.11a/g specification; 27 Mbps is
from HIPERLAN/2.

Table 5-1 lists key parameter values of 802.11a/g.

5. IdleInterval specifies the idle interval between two consecutive bursts when
generating a 802.11a signal source.

6. For DataType:

• if PN9 is selected, a 511-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.153.

• if PN15 is selected, a 32767-bit pseudo-random test pattern is generated
according to CCITT Recommendation O.151.

Table 5-1. Rate-Dependent Values

Data Rate
(Mbps) Modulation Coding Rate (R)

Coded Bits per
Subcarrier
( )

Coded Bits per
OFDM Symbol
( )

Data Bits per
OFDM Symbol
( )

6 BPSK 1/2 1 48 24

9 BPSK 3/4 1 48 36

12 QPSK 1/2 2 96 48

18 QPSK 3/4 2 96 72

24 16-QAM 1/2 4 192 96

27 16-QAM 9/16 4 192 108

36 16-QAM 3/4 4 192 144

48 64-QAM 2/3 6 288 192

54 64-QAM 3/4 6 288 216

NBPSC NCBPS NDBPS
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• if FIX4 is selected, a zero-stream is generated.

• if x_1_x_0 is selected (where x equals 4, 8, 16, 32, or 64) a periodic bit stream
is generated, with the period being 2 x. In one period, the first x bits are 1s
and the second x bits are 0s.

7. DataLength is used to set the number of data bytes in a burst. There are 8 bits
per byte.

8. GuardInterval is used to set cyclic prefix in an OFDM symbol. The value range
of GuardInterval is [0.0,1.0]. The cyclic prefix is a fractional ratio of the IFFT
length. 802.11a/g defines GuardInterval=1/4 (0.8 µsec) and HIPERLAN/2
defines two GuardIntervals (1/8 and 1/4).

Adjacent Channel Rejection Parameters

1. AdjChFSourceOffset: Adjacent channel carrier frequency offset.

2. AdjChPower: Adjacent channel power.

Measurement Parameters

This measurement requires setting of the MirrorMeasSpectrum parameter such that
there is an even number of spectrum mirrorings from the combined test bench source
and RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its
output RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.

1. DisplayPages provides Data Display page information for this measurement. It
cannot be changed by the user.

2. DecoderType has three modes: Hard, Soft, and CSI. When DecoderType=Hard,
if b < 0, -1.0 is output, otherwise 1.0 is output; when DecoderType=Soft, if b <
-1.0, -1.0 is output; if b > 1.0, 1.0 is output; when DecoderType=CSI, b is
multiplied by CSI (= |H(i)|2) and output. CSI means Channel Status
Information and estimated channel impulse responses (H(i)) are the CSI here.

3. TrunLen sets the most recent TrunLen information bits in each surviving
sequence are stored. Once the path with the shortest distance is identified, the
symbol associated with the path TrunLen periods ago is conveyed to the output
as a decoded information symbol.
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4. StartBurst sets the start burst. A value of 0 is the first burst.

5. StopBurst sets the stop burst. A StopBurst value of 100 results in measuring
101 bursts.

Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for
each measurement activated.

Note Measurement results from a wireless test bench have associated names that can
be used in Data Display Expressions. For more information, refer to Appendix B,
Measurement Results for Expressions.

Measurement

This measurement shows BER and PER results.

Adjacent or non-adjacent channel rejection is measured by setting the desired signal
strength 3 dB above the rate-dependent sensitivity (as specified in Table 91 of IEEE
Std. 802.11a-1999) and raising the power of the interfering signal until the 10%
packet error rate (PER) is caused for a DataLength (PSDU) of 1000 bytes. The power
difference between the interfering and the desired channel is the corresponding
adjacent or non-adjacent channel rejection. The interfering signal in the adjacent or
non-adjacent channel must be a conformant OFDM PHY signal, unsynchronized with
the signal in the channel under test. For a conformant OFDM PHY the corresponding
rejection must be no less than that specified in Table 91 of IEEE Std. 802.11a-1999
and listed in Table 5-2.

Table 5-2. Receiver Requirements

Data Rate
(Mbps)

Minimum
Sensitivity
(dBm)

Adjacent
Channel
Rejection (dB)

Alternate
Adjacent Channel
Rejection (dB)

6 -82 16 32

9 -81 15 31

12 -79 13 29

18 -77 11 27

24 -74 8 24
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Simulation results for data rate of 54 Mbps with SourcePower at -62 dBm are shown
in Figure 5-6.

The receiver channel rejection is defined in Table 91 of IEEE Std. 802.11a-1999. The
PER shall be less than 10% when the power of the interfering signal is raised to the
rate-dependent channel rejection level.

Figure 5-6. Simulation Results for 54 Mbps data rate and -62 dBm SourcePower

36 -70 4 20

48 -66 0 16

54 -65 -1 15

Table 5-2. Receiver Requirements

Data Rate
(Mbps)

Minimum
Sensitivity
(dBm)

Adjacent
Channel
Rejection (dB)

Alternate
Adjacent Channel
Rejection (dB)
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Test Bench Variables for Data Displays

The following tables identify the reference variables used to set up this test bench:

Table 5-3. Test Bench Constants for WLAN Signal Setup

Constant  Value

MinFFT_Size 64 (= 2^6)

BitsPerByte 8

ServiceBits 16

TailBits 6

Ratio Oversampling ratio related to the OversamplingOption as Ratio =
2^OversamplingOption

DataBitsPerOFDMSymbol Dependent on DataRate in Table 5-4.

OFDMSymbolsPerBurst (int ((ServiceBits+BitsPerByte*DataLength+TailBits)/
DataBitsPerOFDMSymbol))+Tail

TailCondition ServiceBits+BitsPerByte*DataLength+TailBits - DataBitsPerOFDMSymbol *(int
((ServiceBits+BitsPerByte*DataLength+TailBits)/ DataBitsPerOFDMSymbol))

Tail if (TailCondition = 0) then 0 else 1

Table 5-4. DataRate Determines
DataBitsPerOFDMSymbol and BitRate Values

DataRate

DataBitsPerOFDMSymbol
(Table 5-3)

BitRate
(Table 5-5)

Mbps_6 24 6e6

Mbps_9 36 9e6

Mbps_12 48 12e6

Mbps_18 72 18e6

Mbps_24 96 24e6

Mbps_27 108 27e6

Mbps_36 144 36e6

Mbps_48 192 48e6

Mbps_54 216 54e6
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Baseline Performance
• Test Computer Configuration

• Pentium IV 2.4 GHz, 512MB RAM, Red Hat Linux 7.3

• Conditions

• Measurements made with default test bench settings.

Table 5-5. Test Bench Equations Derived from
Test Bench Parameters and Exported to the Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

RF_SourceTemp SourceTemp in degrees Celcius

TimeStep 1/(Bandwidth*Ratio)
This is the test bench simulation time step.

OFDM_SymbolTime MinFFT_Size*(1+GuardInterval)/Bandwidth
This is the duration for one OFDM symbol.

OFDM_SymbolsPerBurst OFDMSymbolsPerBurst
This is the number of OFDM symbols in the Data field of a burst.

OFDM_SymbolGuardInterval GuardInterval
This is the guard interval (as a ratio of the OFDM_SymbolTime) associated with each
OFDM symbol.

IdleTime IdleInterval
This is the duration of the zero level idle field at the front of each burst.

ShortPreambleTime 8.0 usec
This is the duration of the short preamble field after the idle field in each burst.

LongPreambleTime 8.0 usec
This is the duration of the long preamble field after the short preamble field in each burst.

SIGNAL_Time OFDM_SymbolTime
This is the duration of the SIGNAL field after the long preamble field in each burst.

DataTime OFDM_SymbolsPerBurst*OFDM_SymbolTime
This is the duration of the Data field after the SIGNAL field in each burst.

BurstTime IdleTime + ShortPreambleTime + LongPreambleTime + SIGNAL_Time + DataTime

BytesPerBurst DataLength
This is the number of bytes of data in the Data field in each burst.

BitRate Dependent on DataRate in Table 5-4
This is the bit rate for transmitted WLAN signal.

Meas_FMeasurement FMeasurement

MeasR MeasR
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• RF DUT is an RF system behavior component.

• Number of time points in one WLAN 802.11a burst is a function of
Bandwidth, OversamplingOption, IdleInterval, GuardInterval, DataRate,
DataLength

Bandwidth = 20 MHz
OversamplingOption = Option 3 for Ratio 8
IdleInterval = 4 µsec
GuardInterval = 0.25
DataRate = 54 Mbps
DataLength = 1000

• Resultant WTB_TimeStep = 6.25 nsec; BurstTime = 176 µsec; time points per
burst = 2816

• Simulation time and memory requirements.

Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench
and the RF DUT Circuit Envelope simulation with the same signal and number of
time points. For example, if the RF DUT performance with Circuit Envelope
simulation alone takes 2 hours and consumes 200 MB of memory (excluding the
memory consumed by the core ADS product), then add these numbers to the Baseline
Performance numbers to determine the expected ADS performance. This is valid only
if the full memory consumed is from RAM. If RAM is less, larger simulation times
may result due to increased disk access time for swap memory usage.
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Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench
Simulation documentation to learn how to improve simulation speed.

WLAN Links

European Radiocommunications Office: http://www.ero.dk

U.S. Frequency Allocations Chart: http://www.ntia.doc.gov/osmhome

IEEE 802.11b Compliance Organization: http://www.wi-fi.org

HomeRF Resource Center: http://www.homerf.org

IEEE 802.11 Working Group: http://grouper.ieee.org/groups/802/11/index.html
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Appendix A: RF DUT Limitations
This appendix describes test bench use with typical RF DUTs, improving test bench
performance when certain RF DUT types are used, and improving simulation fidelity.
Two sections regarding special attention for Spectum and EVM transmission
measurements is also included.

The RF DUT, in general, may be a circuit design with any combination and quantity
of analog and RF components, transistors, resistors, capacitors, etc. suitable for
simulation with the Agilent Circuit Envelope simulator. More complex RF circuits
will take more time to simulate and will consume more memory.

Test bench simulation time and memory requirements can be considered to be the
combination of the requirements for the baseline test bench measurement with the
simplest RF circuit plus the requirements for a Circuit Envelope simulation for the
RF DUT of interest.

An RF DUT connected to a wireless test bench can generally be used with the test
bench to perform default measurements by setting the test bench Required
Parameters. Default measurement parameter settings can be used (exceptions
described below), for a typical RF DUT that:

• Requires an input (RF) signal with constant RF carrier frequency.

The test bench RF signal source output does not produce an RF signal whose
RF carrier frequency varies with time. However, the test bench will support an
output (RF) signal that contains RF carrier phase and frequency modulation as
can be represented with suitable I and Q envelope variations on a constant RF
carrier frequency.

• Produces an output (Meas) signal with constant RF carrier frequency.

The test bench input (Meas) signal must not contain a carrier frequency whose
frequency varies with time. However, the test bench will support an input
(Meas) signal that contains RF carrier phase noise or contains time varying
Doppler shifts of the RF carrier. These signal perturbations are expected to be
represented with suitable I and Q envelope variations on a constant RF carrier
frequency.

• Requires an input (RF) signal from a signal generator with a 50-ohm source
resistance. Otherwise, set the SourceR parameter value in the Basic Parameters
tab.
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RF DUT Limitations
• Requires an input (RF) signal with no additive thermal noise (TX test benches)

or source resistor temperature set to 16.85oC (RX test benches). Otherwise, set
the SourceTemp (TX and RX test benches) and EnableSourceNoise (TX test
benches) parameters in the Basic Parameters tab.

• Requires an input (RF) signal with no spectrum mirroring. Otherwise, set the
MirrorSourceSpectrum parameter value in the Basic Parameters tab.

• Produces an output (Meas) signal that requires a 50-ohm external load
resistance. Otherwise, set the MeasR parameter value in the Basic Parameters
tab.

• Produces an output (Meas) signal with no spectrum mirroring. Otherwise, set
the MirrorMeasSpectrum parameter value in the Basic Parameters tab.

• Relies on the test bench for any measurement-related bandpass signal filtering
of the RF DUT output (Meas) signal.

• When the RF DUT contains a bandpass filter with bandwidth that is on the
order of the test bench receiver system (~1 times the test bench receiver
bandwidth) and the user wants a complete characterization of the RF DUT
filter, the default time CE_TimeStep must be set smaller.

• When the RF DUT bandpass filter is much wider than the test bench receiver
system (>2 times the test bench receiver bandwidth), the user may not want
to use the smaller CE_TimeStep time step to fully characterize it because the
user knows the RF DUT bandpass filter has little or no effect in the
modulation bandwidth in this case.

Improving Test Bench Performance

This section provides information regarding improving test bench performance when
certain RF DUT types are used.

• Analog/RF models (TimeDelay and all transmission line models) used with
Circuit Envelope simulation that perform linear interpolation on time domain
waveforms for modeling time delay characteristics that are not an integer
number of CE_TimeStep units. Degradation is likely in some measurements,
especially EVM.

This limitation is due to the linear interpolation between two successive
simulation time points, which degrades waveform quality and adversely affects
EVM measurements.
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To avoid this kind of simulator-induced waveform quality degradation: avoid
use of Analog/RF models that rely on linear interpolation on time domain
characteristics; or, reduce the test bench CE_TimeStep time step by a factor of 4
below the default CE_TimeStep (simulation time will be 4 times longer).

• Analog/RF lumped components (R, L, C) used to provide bandpass filtering with
a bandwidth as small as the wireless signal RF information bandwidth are
likely to cause degradation in some measurements, especially Spectrum. These
circuit filters require much smaller CE_TimeStep values than would otherwise
be required for RF DUT circuits with broader bandwidths.

This limitation is due to the smaller Circuit Envelope simulation time steps
required to resolve the differential equations for the L, C components when
narrow RF bandwidths are involved. Larger time steps degrade the resolution
of the simulated bandpass filtering effects and do not result in accurate
frequency domain measurements, especially Spectrum and EVM
measurements (when the wireless technology is sensitive to frequency domain
distortions).

To determine that your lumped component bandwidth filter requires smaller
CE_TimeStep, first characterize your filter with Harmonic Balance simulations
over the modulation bandwidth of interest centered at the carrier frequency of
interest. Though it is difficult to identify an exact guideline on the Circuit
Envelope time step required for good filter resolution, a reasonable rule is to set
the CE_TimeStep to 1/(double-sided 3dB bandwidth)/32.

To avoid this kind of simulator-induced waveform quality degradation, avoid
the use of R, L, C lumped filters with bandwidths as narrow as the RF signal
information bandwidth, or reduce the CE_TimeStep.

• Analog/RF data-based models (such as S-parameters and noise parameters in
S2P data files) used to provide RF bandpass filtering with a bandwidth as small
as 1.5 times the wireless signal RF information bandwidth are likely to cause
degradation in some measurements, especially EVM.

This limitation is due to causal S-parameter data about the signal carrier
frequency requiring a sufficient number of frequency points within the
modulation bandwidth; otherwise, the simulated data may cause degraded
signal waveform quality. In general, there should be more than 20 frequency
points in the modulation bandwidth; more is required if the filter that the
S-parameter data represents has fine-grain variations at small frequency steps.
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RF DUT Limitations
To avoid this kind of simulator-induced waveform quality degradation, avoid
the use of data-based models with bandwidths as narrow as the RF signal
information bandwidth, or increase the number of frequency points in the data
file within the modulation bandwidth and possibly also reduce the
CE_TimeStep simulation time step.

• An additional limitation exists when noise data is included in the data file.
Circuit Envelope simulation technology does not provide frequency-dependent
noise within the modulation bandwidth for this specific case when noise is from
a frequency domain data file. This may result in output noise power that is
larger than expected; if the noise power is large enough, it may cause degraded
signal waveform quality.

To avoid this kind of simulator-induced waveform quality degradation avoid the
use of noise data in the data-based models or use an alternate noise model.

Improving Simulation Fidelity

Some RF circuits will provide better Circuit Envelope simulation fidelity if the
CE_TimeStep is reduced.

• In general, the default setting of the test bench OversamplingRatio provides
adequate wireless signal definition and provides the WTB_TimeStep default
value.

• Set CE_TimeStep = 1/Bandwidth/OversampingRatio/N

where N is an integer ≥ 1

• When CE_TimeStep is less than the WTB_TimeStep (i.e., N>1), the RF signal
to the RF DUT is automatically upsampled from the WTB_TimeStep and the
RF DUT output signal is automatically downsampled back to the
WTB_TimeStep. This sampling introduces a time delay to the RF DUT of
10×WTB_TimeStep and a time delay of the measured RF DUT output signal of
20×WTB_TimeStep relative to the measured RF signal sent to the RF DUT
prior to its upsampling.

Special Attention for Spectrum Measurements

The Spectrum Measurement spectrum may have a mask against which the spectrum
must be lower in order to pass the wireless specification. The Spectrum measurement
itself is based on DSP algorithms that result in as much as 15 dB low-level spectrum
variation at frequencies far from the carrier.
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To reduce this low-level spectrum variation, a moving average can be applied to the
spectrum using the moving_average(<data>, 20) measurement expression for a
20-point moving average. This will give a better indication of whether the measured
signal meets the low-level spectrum mask specification at frequencies far from the
carrier.

Special Attention for EVM Measurements

For the EVM measurement, the user can specify a start time. The EVM for the initial
wireless segment may be unusually high (due to signal startup transient effects or
other reasons) that cause a mis-detected first frame that the user does not want
included in the RF DUT EVM measurement.

To remove the degraded initial burst EVM values from the RF DUT EVM
measurement, set the EVM_Start to a value greater than or equal to the RF DUT
time delay characteristic.
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RF DUT Limitations
A-6



Appendix B: Measurement Results for
Expressions
Measurement results from a wireless test bench have associated names that can be
used in Expressions. Those expressions can further be used in specifying goals for
Optimization and Monte Carlo/Yield analysis. For details on using expressions, see
the Measurement Expressions documentation. For details on setting analysis goals
using Optimization and Monte Carlo/Yield analysis, see the Tuning, Optimization,
and Statistical Design documentation.

You can use an expression to determine the measurement result independent
variable name and its minimum and maximum values. The following example
expressions show how to obtain these measurement details where MeasResults is the
name of the measurement result of interest:

• The Independent Variable Name for this measurement result is obtained by
using the expression

indep(MeasResults)

• The Minimum Independent Variable Value for this measurement result is
obtained by using the expression

min(indep(MeasResults))

• The Maximum Independent Variable Value for this measurement result is
obtained by using the expression

max(indep(MeasResults))

Table B-1 through Table B-5 list the measurement result names and independent
variable name for each test bench measurement. Expressions defined in a MeasEqn
block must use the full Measurement Results Name listed. Expressions used in the
Data Display may omit the leading test bench name. You can also locate details on
the measurement result minimum and maximum independent variable values by

• Referring to the measurement parameter descriptions when they are available
(not all measurement parameter descriptions identify these minimum and
maximum values).

• Observing the minimum and maximum independent variable values in the
Data Display for the measurement.
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Measurement Results for Expressions
Table B-1. WLAN_802_11a_TX Measurement Results

Measurement Results Name Independent Variable Name

Envelope

WLAN_802_11a_TX.RF_V time

WLAN_802_11a_TX.Meas_V time

Constellation

WLAN_802_11a_TX.RF_Constellation.BPSKConstellation Index

WLAN_802_11a_TX.RF_Constellation.Constellation Index

WLAN_802_11a_TX.RF_Constellation.QAMConstellation Index

WLAN_802_11a_TX.Meas_Constellation.BPSKConstellation Index

WLAN_802_11a_TX.Meas_Constellation.Constellation Index

WLAN_802_11a_TX.Meas_Constellation.QAMConstellation Index

Power

WLAN_802_11a_TX.RF_Power.AvgPower_dBm Index

WLAN_802_11a_TX.RF_Power.CCDF Index

WLAN_802_11a_TX.RF_Power.PeakPower_dBm Index

WLAN_802_11a_TX.RF_Power.SignalRange_dB Index

WLAN_802_11a_TX.Meas_Power.AvgPower_dBm Index

WLAN_802_11a_TX.Meas_Power.CCDF Index

WLAN_802_11a_TX.Meas_Power.PeakPower_dBm Index

WLAN_802_11a_TX.Meas_Power.SignalRange_dB Index

Spectrum

WLAN_802_11a_TX.RF_Spectrum freq

WLAN_802_11a_TX.Meas_Spectrum freq

EVM

WLAN_802_11a_TX.RF_EVM.CPErms_percent Index

WLAN_802_11a_TX.RF_EVM.EVMrms_percent Index

WLAN_802_11a_TX.RF_EVM.EVM_dB Index

WLAN_802_11a_TX.RF_EVM.IQ_Offset_dB Index

WLAN_802_11a_TX.RF_EVM.PilotEVM_dB Index

WLAN_802_11a_TX.RF_EVM.SyncCorrelation Index

WLAN_802_11a_TX.Meas_EVM.CPErms_percent Index

WLAN_802_11a_TX.Meas_EVM.EVMrms_percent Index

WLAN_802_11a_TX.Meas_EVM.EVM_dB Index

WLAN_802_11a_TX.Meas_EVM.IQ_Offset_dB Index
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WLAN_802_11a_TX.Meas_EVM.PilotEVM_dB Index

WLAN_802_11a_TX.Meas_EVM.SyncCorrelation Index

Table B-2. WLAN_802_11b_TX Measurement Results

Measurement Results Name
Independent Variable
Name

Envelope

WLAN_802_11b_TX.RF_V time

WLAN_802_11b_TX.Meas_V time

Constellation

WLAN_802_11b_TX.RF_Constellation.Header_Constellation Index

WLAN_802_11b_TX.RF_Constellation.Preamble_Constellation Index

WLAN_802_11b_TX.RF_Constellation.PSDU_Constellation Index

WLAN_802_11b_TX.Meas_Constellation.Header_Constellation Index

WLAN_802_11b_TX.Meas_Constellation.Preamble_Constellation Index

WLAN_802_11b_TX.Meas_Constellation.PSDU_Constellation Index

Power

WLAN_802_11b_TX.RF_Power.AvgPower_dBm Index

WLAN_802_11b_TX.RF_Power.CCDF Index

WLAN_802_11b_TX.RF_Power.PeakPower_dBm Index

WLAN_802_11b_TX.RF_Power.SignalRange_dB Index

WLAN_802_11b_TX.Meas_Power.AvgPower_dBm Index

WLAN_802_11b_TX.Meas_Power.CCDF Index

WLAN_802_11b_TX.Meas_Power.PeakPower_dBm Index

WLAN_802_11b_TX.Meas_Power.SignalRange_dB Index

Spectrum

WLAN_802_11b_TX.RF_Spectrum freq

WLAN_802_11b_TX.Meas_Spectrum freq

EVM

WLAN_802_11b_TX.RF_EVM.Avg_EVMrms_pct Index

WLAN_802_11b_TX.RF_EVM.Avg_FreqError_Hz Index

WLAN_802_11b_TX.RF_EVM.Avg_IQ_Offset_dB Index

WLAN_802_11b_TX.RF_EVM.Avg_MagErr_rms_pct Index

WLAN_802_11b_TX.RF_EVM.Avg_PhaseErr_deg Index

Table B-1. WLAN_802_11a_TX Measurement Results (continued)

Measurement Results Name Independent Variable Name
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Measurement Results for Expressions
WLAN_802_11b_TX.RF_EVM.SyncCorrelation Index

WLAN_802_11b_TX.RF_EVM.Avg_WLAN_80211b_1000_chip_Pk_EVM_pct Index

WLAN_802_11b_TX.RF_EVM.EVMrms_pct Index

WLAN_802_11b_TX.RF_EVM.EVM_Pk_chip_idx Index

WLAN_802_11b_TX.RF_EVM.EVM_Pk_pct Index

WLAN_802_11b_TX.RF_EVM.FreqError_Hz Index

WLAN_802_11b_TX.RF_EVM.IQ_Offset_dB Index

WLAN_802_11b_TX.RF_EVM.MagErr_Pk_chip_idx Index

WLAN_802_11b_TX.RF_EVM.MagErr_Pk_pct Index

WLAN_802_11b_TX.RF_EVM.MagErr_rms_pct Index

WLAN_802_11b_TX.RF_EVM.PhaseErr_deg Index

WLAN_802_11b_TX.RF_EVM.PhaseErr_Pk_chip_idx Index

WLAN_802_11b_TX.RF_EVM.PhaseErr_Pk_deg Index

WLAN_802_11b_TX.RF_EVM.SyncCorrelation Index

WLAN_802_11b_TX.RF_EVM.WLAN_80211b_1000_chip_Pk_EVM_pct Index

WLAN_802_11b_TX.Meas_EVM.Avg_EVMrms_pct Index

WLAN_802_11b_TX.Meas_EVM.Avg_FreqError_Hz Index

WLAN_802_11b_TX.Meas_EVM.Avg_IQ_Offset_dB Index

WLAN_802_11b_TX.Meas_EVM.Avg_MagErr_rms_pct Index

WLAN_802_11b_TX.Meas_EVM.Avg_PhaseErr_deg Index

WLAN_802_11b_TX.Meas_EVM.SyncCorrelation Index

WLAN_802_11b_TX.Meas_EVM.Avg_WLAN_80211b_1000_chip_Pk_EVM_pct Index

WLAN_802_11b_TX.Meas_EVM.EVMrms_pct Index

WLAN_802_11b_TX.Meas_EVM.EVM_Pk_chip_idx Index

WLAN_802_11b_TX.Meas_EVM.EVM_Pk_pct Index

WLAN_802_11b_TX.Meas_EVM.FreqError_Hz Index

WLAN_802_11b_TX.Meas_EVM.IQ_Offset_dB Index

WLAN_802_11b_TX.Meas_EVM.MagErr_Pk_chip_idx Index

WLAN_802_11b_TX.Meas_EVM.MagErr_Pk_pct Index

WLAN_802_11b_TX.Meas_EVM.MagErr_rms_pct Index

WLAN_802_11b_TX.Meas_EVM.PhaseErr_deg Index

WLAN_802_11b_TX.Meas_EVM.PhaseErr_Pk_chip_idx Index

WLAN_802_11b_TX.Meas_EVM.PhaseErr_Pk_deg Index

Table B-2. WLAN_802_11b_TX Measurement Results

Measurement Results Name
Independent Variable
Name
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WLAN_802_11b_TX.Meas_EVM.SyncCorrelation Index

WLAN_802_11b_TX.Meas_EVM.WLAN_80211b_1000_chip_Pk_EVM_pct Index

Table B-3. WLAN_802_11a_RX_Sensitivity Measurement Results

Measurement Results Name
Independent Variable
Name

RX Sensitivity

WLAN_802_11a_RX_Sensitivity.Meas_BERPRER.BER Index

WLAN_802_11a_RX_Sensitivity.Meas_BERPRER.PER Index

Table B-4. WLAN_802_11b_RX_Sensitivity Measurement Results

Measurement Results Name
Independent Variable
Name

RX ACR

WLAN_802_11b_RX_Sensitivity.Meas_BERPRER.BER Index

WLAN_802_11b_RX_Sensitivity.Meas_BERPRER.PER Index

Table B-5. WLAN_802_11a_RX_ACR Measurement Results

Measurement Results Name
Independent Variable
Name

RX ACR

WLAN_802_11a_RX_ACR.Meas_BERPRER.BER Index

WLAN_802_11a_RX_ACR.Meas_BERPRER.PER Index

Table B-2. WLAN_802_11b_TX Measurement Results

Measurement Results Name
Independent Variable
Name
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